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Thank you for purchasing Gorilla, the all-in-one software tool that will help you 
produce your movie. We at Jungle Software are very excited about this new 
release. We have added over 60 new features to Version 3.0, plus enhanced the 
user interface to make Gorilla even easier to use. 

Just as your story has a beginning, middle, and end, so does the creation of 
your movie.  Our software, and this manual, will help to guide you through the 
various steps as you write, produce, and eventually distribute your project. 

We would like to thank the innumerable independent filmmakers who helped 
us make Gorilla what it is today.  Your suggestions and advice continue to make 
us strive to improve this system for producing movies.  We created Gorilla for 
you, and we sincerely hope that Gorilla helps to bring your story to the big 
screen. 

2.1 Installation 
Windows Installation 

To install Gorilla for Windows, do the following: 

1. From the CD, select the WIN folder. 

2. Double-click Setup.exe. 

3. Follow the instructions in the installer. 

4. When the installer finishes, a folder named Gorilla 3.0 will be placed in 
the Program Files directory. 

5. A shortcut will be placed in the Startup menu. 

6. Launch the application either by the shortcut in the Startup menu or 
double-clicking the Gorilla 3.0 icon in the Gorilla 3.0 folder. 
 
Continue with Step 7  

Macintosh installation 

To install Gorilla on Macintosh OS 9 or OS X, do the following: 

1. From the CD, select the MAC folder. 

2. Double-click Install Gorilla 3.0. 

3. Follow the instructions in the installer. 
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4. When the installer finishes, a folder named Gorilla 3.0 will be placed in 
the Applications directory. 

5. Launch the application by double-clicking the Gorilla 3.0 icon in the 
Gorilla 3.0 folder 

6. If you wish, drag this icon to your dock. 
 
----------------------------------------------------------------------- 

7. Enter your name and company name as it appears in your registration 
confirmation e-mail. 

8. In the activation screen, enter your serial number. This number begins 
with a PR (Pro Edition), or SD (Standard Edition), or ST (Student Edition). 
(See Section 2.1-1 Registering Gorilla). 

9. The next step is to authorize Gorilla. 

Internet Authorization 

 

If your computer is connected to the internet, click Internet. Gorilla 
will authorize in a few seconds. If your computer is not connected to the 
internet, either authorize Gorilla at a later time or authorize Gorilla 
manually. 

Manual Authorization 

To manually authorize Gorilla, contact Jungle Software with your 
Machine ID and your Challenge Code. We will give you a Response Code. 
Enter the Response Code to authorize Gorilla. 

10. Enter a password and a hint. 

11. To login to the program, select your name and type in your password. 
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12. From the Quick Tips Screen, click Launch Gorilla. 

13. From the Select Project Screen, click New to create a new project, or 
Load to load a schedule file (.grs) or a budget file (.grb). 

14. Enter a project title on the Projects/Story Screen. When finished, click 
the name of the project to make it active. 

2.1-1 Registering Gorilla 
Gorilla is registered by entering a unique serial number. 

If you purchased the CD (versus the downloadable version), a Box Code is 
included on a yellow card. This box code is not the serial number. In order to 
receive the serial number, do the following: 

1. Via Internet: Go to www.junglesoftware.com and click Register. Enter 
your name (minimum of 8 characters), company name (minimum of 8 
characters), and a valid email address. A serial number will be emailed 
within minutes. 

2. Via Phone: Call our Los Angeles office between the hours of 10am – 6pm 
PST (Pacific Standard Time). The phone number is: (818) 508-7090. 
Please have your box code, name, and company name ready. We will 
give you the serial number over the phone. 

To register Gorilla, enter your name and company name exactly as you entered 
them when you requested the serial number. 

http://www.junglesoftware.com/
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2.1-2 Authorizing Gorilla 
Gorilla must be authorized within five days of being registered.  If Gorilla is not 
authorized within 5 days of being registered, the program will not launch. 

With every single-user copy of Gorilla purchased, the software owner is allowed 
to authorize Gorilla on two (2) computers. 

Both of these computers must be owned by the owner of the software. You 
are not allowed to give a friend (whether they are your producer or not!) a 
copy of Gorilla to use on their computer while you are using a copy of Gorilla 
on your computer. 

Authorizing Gorilla can be accomplished via the internet or by phone.  

Gorilla will prompt you to authorize each time it is launched until you do so. 

For special pricing on multi-user licenses, please contact Jungle Software. 

 Important Note: Gorilla must be registered before it can be authorized. 

2.1-3 Deauthorizing Gorilla 
If you are replacing your computer, you may wish to deauthorize Gorilla.  To do 
so, launch Gorilla and click Admin on the Main Menu. Click the 
Upgrade/Authorize tab and then click Deauthorize.  
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2.2 Interface 

2.2-1 The Main Menu and The Gorilla Menu 
Use the Main Menu to navigate 
throughout Gorilla. The Main Menu is 
visible on the right side of the screen. 
By clicking a selection, the related 
selections associated with that choice 
appear below.  Click one of these 
selections to navigate to that part of 
the program. 

 

 

The Main Menu can be accessed by typing Command-M or selecting Main Menu 
from the Go Menu. 
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2.2-2 Interface for Screens 
Gorilla uses the same interface for most of its screens. 

The Toolbar and Tabs 

 

1) The Toolbar has the following buttons (some screens may have slightly 
different buttons): 

Tools on the Toolbar 

 New  Add a new record (i.e. 
Character, Breakdown 
Sheet, Budget Line Item, 
etc.). 

 Delete Delete the currently 
selected record. 

 Find Search for a record or a 
group of records. 

+  Find All Find all records. 

 Sort Sort the currently found 
records. 

 List Show the currently found 
records as a list. 

 Print Print a report.  

 Import Import records from an 
external data source. 

 Export Export records to an 
external source. 

 Help Show balloon help for the 
current screen (not 
available on all screens). 

 

Return to Main 
Menu 

To return to the Main 
Menu and close the 
current screen. 

2) Most screens will have tabs to navigate within the module. The tab 
selections will differ depending on the module.  



General 

-7- 

Example: These are the tabs for Scheduling. 

 

The selections for Scheduling are: 

• Shoot Days 
• Breakdown 
• Categories 
• Elements 
• Storyboard 
• Stripboard 

In the example above, the current screen is the Breakdown Screen. We know 
this because the breakdown tab is blue. 

 

Sometimes these screens can be accessed directly 
from the Main Menu. 

For example, by clicking Scheduling on the Main 
Menu, there is an option to navigate directly to the 
Breakdown Sheets. 

 

Gorilla Menus and Keyboard Shortcuts 

The menus at the top of 
the screen will differ 
depending on what Gorilla 
module you are using.  
Many of the selections 
will have a keyboard 
shortcuts associated with 
them.  In the example to 
the right, command-E is 
another way to choose 
Delete Character. 

 
 

Navigating Through Records 

To navigate from one record to the next, use the navigational buttons 
 on the lower left-hand side of the screen. 



General 

-8- 

Gorilla will only navigate to records that are in the Current Found Set. To filter 
the found set, click Find  to perform a record search. 

Alternatively, to expand the found set to all records, click Find All +  on the 
Toolbar. 

Found Set of Records 

On most screens, the Record Count shows how many records are in the found 
set. 

 

 Important Note: In many cases you will only be able to see records from 
the currently active project.  In order to see the records in another project, 
you must switch projects (see Section 5.1-3 Switching Project). 

Finding Records 

To search for a 
group of records, 
click  on the 
Toolbar. The Find 
Screen will appear, 
which looks similar 
to the previous 
screen, but with a 
different Toolbar. 

 

 

Enter a find request in the appropriate field(s) and then click Perform 
Search. 

To search for multiple requests at the same time, click Add New Request and 
create another search on the new Find Screen. 

For example, to search for all lead characters or all supporting characters, do 
the following: 

1. On the Find Screen, select the type Lead. 

2. Click Add New Request.  A new Find Screen will appear.  

3. In the new Find Screen, select the type Supporting.  
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4. Click Perform Search. 

To search for some records while omitting others, use the Omit checkbox. For 
example, to search for all male characters while omitting lead characters, do 
the following: 

1. On the Find Screen, select the sex Male. 

2. Click Add New Request. 

3. Select the type Lead. 

4. Click Omit in the left side bar.  

5. Click Perform Search. 

Notice in the example to the right:  
On the left-hand side displays 
Requests: 2. This means that the 
find request has two (2) search 
criteria.  

Mathematical symbols can also used to 
specify more exact search criteria, 
such as greater than, less than, range, 
etc.  

For example, to search for numbers in the range of 5 to 15, enter 5...15 in the 
search field. 

Find and Replace 

It is possible to find a word throughout the Contacts, Characters, or Scheduling 
Modules, and replace it with another word. 

To access the Find/Replace Window, SHIFT-click Find on the toolbar. 
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To find or replace invisible characters, such as tabs or carriage returns, 
manually copy and paste these characters from a field into the Find What or 
Replace With Fields.  Likewise, typing the space bar in the Find What Window 
will alter the search to only find words that include the space. 

The following table explains some of the other features of the Find/Replace 
Window. 

Options in the Find/Replace Window 

Select To 

Direction List Choose the search direction: Forward, 
Backward, or All. 

Match Case Checkbox Search for only those occurrences in which the 
capitalization matches the data specified in the 
Find What Field. 

Match Whole Words Only 
Checkbox 

Search for only those occurrences that are whole 
words. 

Search Across Choose Current Record to search the currently 
viewed screen.  Choose All Records to search 
throughout the module. 

Search Within Choose Current Field to search the current 
field.  Choose All Fields to search every field. 

Find Next Search for and select the next occurrence of the 
contents of the Find What Field. 

Replace & Find Replace the next occurrence of the contents of the 
Find What Field with the contents of the Replace 
With Field, and then find the next occurrence. 

Replace Replace the next occurrence of the contents of the 
Find What Field with the contents of the Replace 
With Field. 

Replace All Replace all occurrences of the contents of the Find 
What Field with the contents of the Replace With 
Field.  A summary of the number of occurrences 
found and replaced will appear. 

Printing 

To print a report, click Print  on the toolbar and click the desired report.  
Gorilla can print over 70 industry standard reports. 
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2.3 Importing/Exporting 
Many of Gorilla’s modules have 
the ability to import or export 
records to various file formats.  
These features can be accessed 
from the File Menu.  

 

Importing 

When importing records, Gorilla will display an import map:  a list of the fields 
Gorilla wants, and the order in which it wants them.   

Below is an example of a Character Import Map: 

 

Exporting 

When exporting records, Gorilla will display an export map: a list of the fields 
that will be exported, in the order they will be exported. 

Below is an example of the Character Export Map: 
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Gorilla will export only the currently found records. To export all records, click 
Find All before clicking Export. 

2.4 Saving Gorilla 
Gorilla saves itself every time the user makes a change.  The data is 
automatically merged with the application in the .GOR files.  

Budgets and Schedules can be saved to external files that can be emailed to 
other Gorilla Users.  More information about this is available is Section 9.9 
Save/Load Schedule and Section 10.7 Saving/Loading Budgets. 

It is, however, very important to always keep a recent backup of the Gorilla 
folder in case of a system or hard drive crash. 

 Important Note: Do not keep multiple copies of a Gorilla folder on the 
same hard drive. This is because the Gorilla application might open a file in 
another Gorilla folder and the data would be read from the wrong place. To 
save (or archive) a Gorilla folder for back-up, follow the recommended backup 
procedure explained below. 

To create a backup of a Gorilla folder on a hard drive, we recommend using a 
compression program such as WinZip® (for Windows) or Stuffit® (for 
Macintosh). Compress the entire Gorilla folder and name it with the current 
date. 
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In this way, multiple copies of the compressed Gorilla folder can be saved on 
the same hard drive. It is also a good idea to periodically copy these archives to 
an external media source, such as a CD, Zip drive, or a network drive. 

 Important Note: Exit Gorilla before making a backup.  Gorilla files can 
be damaged if a backup is attempted while Gorilla is open. 

2.5 System/FileMaker Extensions Folder 
In the Gorilla 3.0 folder, there is a System Folder (Windows) or a FileMaker 
Extensions Folder (Macintosh). Inside this folder are plug-ins and dictionary 
files that are required to run Gorilla.  

Do not move or delete this folder or the contents inside the folder. 

2.6 Recovering Corrupted Files 
If your computer crashes for any reason while Gorilla files are open, Gorilla 
might get corrupted. Gorilla can usually repair a corrupted file on its own. 
Gorilla will display the message This file was not closed properly.  
If in the rare case the file cannot open, the file needs to be recovered using 
FileMaker Pro™ version 5 or 6. 

If you own FileMaker Pro (www.filemaker.com), you can attempt to repair the 
file yourself. 

Please read the instructions on how to repair a recovered file from the 
documentation that came with FileMaker Pro. 

Make note of the name of the file before recovering it, because after the file is 
recovered, the file must be renamed the ORIGINAL NAME. 

If you do not own a copy of FileMaker Pro, send Jungle Software your corrupted 
file and we will attempt to recover it. Please stuff or zip all files before 
sending them to us. E-mail your corrupted file to: 
support@junglesoftware.com. We will try to return your file to you within 48 
hours. 

http://www.filemaker.com/
mailto:support@junglesoftware.com


General 

-14- 

If your file cannot be recovered, reinstall Gorilla from a backup or from the 
installer.  You can load your saved schedules and budgets into the new file. 

2.7 Screen Help 
Most screens will have a Help Button on the Toolbar. 

By clicking Help, instant on-screen tips appear.  

 

The tips are numbered in the order that make sense to do things. Follow the 
numbers for an explanation of the fields, buttons, and windows. 

To continue using Gorilla, click anywhere on the screen. 
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3.1 Login 
When Gorilla launches, the user is prompted to enter a name and a password. 
The user’s level of access depends on the Security Module setting. 

3.2 Setting Up a New User 
To set up a new user, do the following; 

1. Click Security on the Main Menu, and then click Security/Users. 

2. On the Security Screen Toolbar, click New. 

There are 7 levels of access. Each level accesses different parts of the 
program. For a user that must access all areas of the program, assign this user 
the rank and level of 100, Executive Producer. Other users may have limited 
access based on their rank and level. 

Only users with the rank/level of 100/Executive Producer will be able to 
create, modify, or delete users and their passwords. 

 

On the grid above, a green check means that the user has access to the 
feature, and a red X means the user does not have access.  The user with 
executive producer rank can click on these symbols to toggle between them, 
thus customizing each rank. 

3.2-1 Password 
Passwords must be between 4 and 10 characters. Upon choosing a password, 
verify the password in the verify field.  

It is important to enter a password hint. If you forget your password, this will 
help you remember it. 



Security 

-16- 

Forgotten Passwords 

If you did not enter a hint and forgot your password, contact Jungle Software 
with your activation key.  Upon verification that you are the registered user, 
we will give you an unlocking code. 

Disabling Password Login 

To disable password login to make launching Gorilla faster, do the following:   

1. Click Security on the Main Menu and select Security/Users. 

2. Click Disable Login. 
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Gorilla is divided into 11 modules: 

1. Projects 

2. Characters 

3. Contacts 

4. Calendar 

5. Scheduling 

6. Budgeting 

7. Distribution of Profits 

8. Locations 

9. Accounting 

10. Editing 

11. Film Festivals 

There is a section in this manual for each module.
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5.1 Overview 
A project is a distinct film or video that has its own story and shoot dates. 

5.1-1 Creating a Project 
After logging into Gorilla, the Select Project Screen appears.  

 

To create a new project, do the following: 

1. Click New on the Select Project Screen. 

2. Enter a name for the project in the Project Name Field. 

The Project Screen 

More details about your project can be entered on the Project Screen, which 
can be accessed from the Main Menu by clicking Story, and then selecting 
Projects.  The following table explains the different fields on the Project 
Screen. 
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Fields on the Project Screen 

Field Description 

Project Title The name of the project. 

Genre Specify the genre of the project. Either choose a value from 
the available pull-down list of genres, or enter a new one. 

Writer(s) Enter the name of the writer(s) here. The name(s) entered 
in this field will print out on synopsis reports. 

Project Number This is the project number. This number can be changed. 

Day out of Days Specifies the number of days an actor is held before being 
dropped. 

Production 
Company 

Enter the name of the production company for this project. 

Address The address field is tied to the production company.  

Phone 1 & 2 Enter phone information for the production company. 

One Line 
Description 

This is a place for the one-line pitch. 

Synopsis A short description of the project, usually a few lines long. 

5.1-2 Activating a Project 
In order to make a project active, click the Active 
Project box next to the project number.   

It may take Gorilla several seconds to activate the project.  

5.1-3 Switching Projects 
In order to switch to another project, 
select Switch Project from the File 
Menu.  

The Select Project Screen will appear.  
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This can also be done from the Story Module: 

1. Click Story on the Main Menu and 
select Projects. 

2. Select a project from the list on the 
right-hand side of the screen. 

 

3. Click Main Menu. 
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Specify detailed information about the characters such as sex, age, and the 
type of role in the Characters Module. 

Upon entering Characters for the first time, Gorilla will ask whether characters 
are to be entered manually or from a screenplay program.  Gorilla imports 
characters and breakdown sheet information from Final Draft® and Movie 
Magic® Screenwriter. 

6.1 Entering Characters Manually 
The Characters Module has three tabs. 

Screens in the Characters Module 

Selection Fields 

Stats Name, Type (Lead, Supporting, Featured, 
Extra, Character), Actor Cast, Sex, 
Age/Range, Description, Casting 
Description, Notes 

Scenes No. of Scenes, Scene Info (from 
Breakdown Sheets), Speaks 

Rehearsals Session ID, Date, Time, Location, Time 
Actor Needed, Confirmed 

At the very least, enter the following: Character Name and Scheduling ID. 

6.1-1 Description vs. Casting Description 
Use the Description Field on the Stats screen to enter detailed information 
about the characters. This information will help actors as they prepare for or 
consider a role. 

Use the Casting Description field to enter a short description of the character. 
This information is helpful when printing a Casting Report for a casting director 
or to print in a trade paper for casting calls. 

6.1-2 Scenes Screen 
The scenes screen keeps track of every scene in which each character appears.  
This screen will be blank until the scheduling process has begun.  Please see 
Section 9 Scheduling for more information on how to do this. 
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6.1-3 Rehearsals Screen 
The Rehearsals Screen keeps track of the rehearsal to which each character 
must attend. This screen will be blank until rehearsals are scheduled.  Please 
see Section 8 Calendar for more information on how to do this. 

6.2 Importing Characters and Breakdown Sheets from a 
Screenplay Program 

Gorilla can import characters and breakdown sheet information from Final 
Draft, Movie Magic Screenwriter, or an Excel-type spreadsheet. 

6.2-1 Preparing the Screenplay 
Before importing from a screenplay program, the screenplay must be properly 
formatted. Make sure that: 

1. All scene headings are numbered with a unique number. 

2. Action line items are not designated as scene headings. 

Importing Elements 

Gorilla can import elements from either Movie Magic Screenwriter or Final 
Draft 7 with Tagger.  These elements must be in the following categories: 

• Extras 
• Stunts 
• Vehicles 
• Props 
• Special Effects 
• Costumes 
• Makeup 
• Livestock 
• Animal Handler 
• Music 
• Sound 
• Set Dressing 
• Greenery 
• Special Equipment 
• Security 
• Additional Labor 
• Optical FX 
• Mechanical FX 
• Miscellaneous 
• Notes 
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 Important Note: Movie Magic Screenwriter’s “auto-entry” option for 
DAY/NIGHT is not compatible with Gorilla.  These Day/Night fields will NOT be 
imported into the breakdown sheets. 

6.2-2 Exporting the Data 
Next, export the information from the screenplay.  

Final Draft 

Final Draft has two ways it can export a screenplay into a format Gorilla can 
read.  

1. Final Draft Without Tagger 

Open the screenplay and make sure that all the scenes are numbered.  To do 
this, click Production on the Command Bar, and select Scene Numbers…  
Select the Number/Renumber checkbox and click OK.  To Export, Click File 
in the Command Bar, and select Save As. In the format dialog box, select 
Movie Magic. 

 

This will save a file with the .RPT extension. 

2. Final Draft 7 With Tagger 

Open Tagger.  Click File on the Command Bar and select Import Script.  
Tag the elements using the preset category names.   

 Important Note: At this time, Gorilla does not support adding or 
modifying category names from within Tagger. 

Select Export to Schedule from the File menu.  This will save a file with 
the .SEX extension. 
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Movie Magic Screenwriter 

Open the screenplay and select Breakdowns from the Production menu and 
then Export to Scheduling. 
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This will save a file with the .SEX extension. 

The export file is now ready for import into Gorilla. 

6.2-3 Importing Screenplay Information into Gorilla 
If there are no breakdown sheets or characters present, Gorilla will 
automatically begin display a prompt to begin the import process.   

Another way to begin the import process is to click Scheduling on the Main 
Menu and then click Breakdown Sheets.  

Select the option Import Screenplay 
from the Tools Menu. 

The following screen will appear:  
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 Important Note: Gorilla cannot import a .FDR (Final Draft file) or a .SCW 
(Movie Magic Screenwriter file) directly into Gorilla. Follow the instructions 
above in order to export the file to the proper format. 

There are two options:  

1. Characters and breakdown sheet information. 

2. Characters, breakdown sheet information, and elements.  

By clicking Options, the import can be further customized. 

If a character in the screenplay is 
tagged with an (O.S.) – the 
abbreviation for Off Screen, or with a 
(V.O.) – the abbreviation for Voice 
Over, Gorilla can either import them 
separately or merge them with the 
character name.   

 

If imported separately, there can be up to three characters in the Characters 
Module that stand for that character. For example, if a character named BILL 
has (O.S.) and/or (V.O.), then the following will be imported into the 
Characters Module: 

BILL 
BILL (O.S.) 
BILL (V.O.) 

In this example, Bill will be broken down on the breakdown sheets following 
that naming convention. This might make it clear when Bill is actually needed 
for that shoot day, or if Bill is only needed for voice over work, which usually is 
done in post-production. 
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All character names with the (CONT) tag will be merged with the character 
name unless the “Do not parse the characters…” has been selected. 

Importing Characters 

Click OK to begin importing the screenplay. 

After Gorilla has successfully imported the characters, the following screen will 
appear. 

 

This is the best time to reorder the Scheduling ID’s. Gorilla, by default, will 
alphabetize the character names and then number them starting from 1. These 
numbers should actually correspond to the strength of the role. For example, 
the two lead characters should be 1 and 2, and supporting roles might be 3, 4, 
5, 6 and 7, etc. This is because the lead characters (the ones that will be 
scheduled most often on breakdown sheets) should be at the top of the 
selection list. This will make it a lot easier to select these characters. 

To change a scheduling ID, click the scheduling ID and renumber it. 

Indicate the type of character (lead, supporting, extra, ect.) by selecting from 
the pop-up list in the Type column. 

To continue, click Import Scenes into Breakdown Sheets. 

The Breakdown sheet information will be imported. 

Checking for Errors 

Please check the breakdown sheets after importing is complete as some 
corrections may be required. For example, if the last word in a screenplay’s 
description line does not read: DAY, NIGHT or another time of day, this field 
will have to be manually fixed. Some writers will write: 

EXT – BUILDING – MOMENTS LATER 

Gorilla will read this as: 
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EXT I/E Field 
BUILDING Set Field 
MOMENTS LATER D/N Field (this is where DAY or NIGHT should be) 

To fix this problem, “Moments Later” will have to be manually changed to a 
time of day. 

6.3 Changing Scheduling ID’s 
To change a character’s scheduling ID, do the following: 

1. Click Story on the Main Menu and then click Characters. 

2. Click the scheduling ID for a character. 

3. The Modify Scheduling ID Screen will appear.  On the left-hand column, 
click the appropriate character. 

4. Type a new number in the New Scheduling ID Field. 

5. Click Convert. 

6. Click Done. 

Each character must be assigned a unique scheduling ID between the numbers 
of 1 and 999. When changing a scheduling ID for a character, Gorilla will reject 
the change if the scheduling ID number is taken by another character. 

6.4 Attaching Characters to Actors 
Characters can be attached to actors, transforming the actors into cast 
members.  To attach a character to an actor, do the following: 

1. Click Story on the Main Menu and click Characters. 

2. Select the type of role for the desired characters. 

3. Click the Not Cast field in the Actor Column. 
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4. Click Yes. 

5. Either select an actor from the list, or create a new actor.  To find an 
actor, use the ABC buttons to filter the list and then click the actors 
name to cast the actor. 

6.4-1 Removing Actors From Characters 
If an actor is no longer playing a role, it is necessary to remove them from the 
character. 

1. Click Story on the Main Menu and click Characters. 

2. Click the actor’s name next to the desired role. 

3. Click Remove. 

6.4-2 Recasting a Character 
To recast an actor, so the following: 

Click Story on the Main Menu and click Characters. 

4. Click the actor’s name next to the desired role. 

5. Click Recast. 

6. Select or create a new actor. 

6.5 Attaching Rates to Characters 
To assist with budgeting, it may be helpful to enter a daily or weekly rate 
associated with a role.  To attach a rate to a character, do the following: 

1. Click Story on the Main Menu and click Characters. 

2. Click the Stats Tab. 
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3. Enter the rate(s) in the Daily Rate and/or Weekly Rate Fields. 

4. Use the Smart Entry feature in the Budgeting Module to import these 
rates directly into your budget. 

For more information about Smart Entry, see Section 10.3-7 Smart Entry. 

6.6 Character Reports  
All reports for the Character Module can be accessed by clicking Print on the 
Toolbar or selecting Print from the File Menu on the Command Bar.  The 
Character reports are: 

• Actor Rehearsal 
• Casting Report 
• Character List 
• Character Profile 
• Rehearsal Sessions 
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7.1 Actors 
Store information about actors in the Contacts Module. To access the Actors 
Screen, click Contacts on the Main Menu and then click Actors. 

7.1-1 Fields on the Actors Screen 
The following are fields on the Actors Screen: 

• First Name 
• Last Name 
• Address 
• City, State, Zip 
• Age 
• Body Type 
• Hair Color 
• Height 
• Weight 
• Color 
• Special Skills 
• Nudity 
• SS# 
• Unions 
• Notes 
• Phone Info 
• Picture/Headshot 

7.1-2 Casting 
When an actor is created and basic information is entered for that actor, that 
actor is stored.  This is a great way to store information about all actors that 
have been interviewed, auditioned, or have sent in a resume and headshot. 

However, that actor is not yet attached to a project. When an actor is attached 
to a project, he or she becomes a Cast Member. 

To cast an actor in a project, Click the Casting tab. The top half of the 
screen shows basic actor information. The bottom half of the screen displays 
the Projects Considered For Window and the Projects Cast In Window. 

 Important Note: A Cast Member is an Actor who is attached to one or 
more projects. 



Contacts 

-32- 

To consider an actor for a role in a project, click the  above the Considered 
For Window. (Characters must have been first imported or created for this to 
work!) 

 

Select a project and then a character. In the example above, this actor is being 
considered for two roles: BILL and NORMAN. 

Use the Considered For Window during casting. Gorilla can generate a report 
listing all the actors that are considered for the roles. 

To cast an actor in a role, click the black down arrow  next to the character 
record. 

The actor will be removed from 
the Considered For Window and 
moved to the Cast In Window.  

Only after actors are recorded in the Cast In Window will Gorilla be able to run 
proper cast reports. 

Conversely, to remove an actor from a role in which he or she was cast, click 
the black up arrow . The actor will be moved to the Considered For Window. 

7.1-3 Removing Actors from Projects 
To remove an actor from the project entirely, click the  next to his or her 
name. 

Although this actor is no longer a cast member, Gorilla will still keep his or her 
record.  This actor will still be available for casting down the road. 

7.1-4 Deleting Actor Records 
To delete an actor, click Delete  located on the Toolbar between New and 
Find, or select Delete Actor from the File Menu. 

 Important Note: Gorilla will not delete an actor if the actor is attached 
to a project or if the actor is considered for a project. 

7.1-5 Adding a Clip 
To import a Quicktime movie clip of an actor’s reel or audition, do the 
following: 
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1. Click Contacts on the Main Menu and click Actors. 

2. Click the Clip Tab. 

3. Click . 

4. Find the desired Quicktime (.mov) file.  

 Important Note: Quicktime files are not included in the saved schedule 
file (.grs).  They are only references that point to the to the .mov file. 

7.1-6 Deleting a Clip 

To delete a clip, click .  This will delete the reference.  The original 
file will still exist on the user’s hard drive. 

7.1-7 Actor Representation 
To Store agent, manager, lawyer, and publicist information for actors, click the 
Representation Tab in the Actors Module. 

 

If a certain agent or lawyer is used over and over, add them to the permanent 

value list by clicking .  This way, the name will be available from a pop-up 
list, and the address and phone info will paste automatically. 

To create a report of actors and their representation, select representation in 
the Report Wizard. 

7.2 Crew 
To create a crew, go to the Main Menu, click Contact, and then click Crew.  
Upon entering this screen for the first time, the Crew Wizard Screen will 
appear, as shown below. 
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Crew can be created individually or by using the Crew Template.  To learn 
more about the Crew Wizard, see Section 7.3 Crew Wizard below. 

7.2-1 Adding Crew Individually 
Each crew member must be attached to a title and a department. Gorilla 
comes preset with many titles.  Use one of the preset titles from the Default 
Title Pull-Down Menu, or create a new title.  (See Section 7.2-2 Creating 
Titles.) 

After attaching a title to a crew member, attach a related department to that 
title. 

Gorilla comes preset with 26 departments. They are:  Accounting, Add’nl Pers., 
Art, Assistants, Camera, Casting, Catering, Construction, Electric, Grip, 
Location, Makeup/Hair, Misc., Others, Picture Cars, Post Prod., Prod. Office, 
Production, Property, Set Dressing, Set Ops, Sound, Special FX, Stud. Teacher, 
Transp., and Wardrobe. 

These department names can be changed by clicking Value List . These 
values can neither be deleted, nor are more than 26 values allowed. 
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 Important Note: Changing the name of the department will affect the 
Create Default Crew option in the Crew Wizard. (See Section 7.3 Crew 
Wizard). 

7.2-2 Creating Titles 
Create new crew titles by altering the Value Lists. To do this, click Admin on 
the Main Menu, and then click Value Lists. From the pop-down menu, select 
Crew Title. 

To add a value to this list, click  and enter the new title. To delete a title 
from the list, click . 

The following titles cannot be deleted: 

• Director 
• Director of Photography 
• Producer 
• Production Designer 
• Production Manager 
• Unit Production Manager 

These titles are required as it will ensure that certain crew member names will 
properly appear in certain reports. 

7.3 Crew Wizard 
The Crew Wizard is a simple and quick way to create a primary crew for a 
project, and easily view all the crew for the current project by department. To 
use the Crew Wizard, click Contacts on the Main Menu, and then click Crew. 
Click the Wizard tab. 

All 26 crew departments are buttons at the right of the screen. Click the 
corresponding button to see all the crew attached to that department for the 
current project. 

To create a basic crew for a particular department, click Create Default X 
Crew located at the right hand side of the screen, where the “X” represents 
the current department.  Depending on which crew button is selected, Gorilla 
will create a default crew and attach these new crew members to the current 
project. 

7.3-1 Customizing the Default Crew Wizard 
The Crew Wizard contains positions typical to feature film crews in the United 
States.  It may be necessary to customize the Crew Wizard to reflect the needs 
of another country or another medium. 
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1. Click Contacts on the Main Menu and select Crew. 

2. Click  on the toolbar. 

3. Click  

4. Choose the department from the pop-up list on the left. 

 

5. Select which of the existing titles the Wizard should include by selecting 
the check boxes on the right. 

6. To create new positions, click Values.  Click , and make sure to 
select the correct department. 

7.4 Attaching Crew to Projects 
After creating a crew member, attach that crew member to a project.  

 Important Note: When using the Crew Wizard, new crew members are 
automatically attached to the current project using their default title and 
default department. 

To attach a crew member to a project, click the Project tab. In the 
Projects This Crew Member Is Attached To Window, click . Select 
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a project from the list of projects. Notice that the crew member’s title and 
department will automatically pop into those corresponding fields. 

7.4-1 Difference between Default Title/Department and 
Project Title/Department 

A crew member is assigned a default title and a default department on the 
Crew Info Screen or using the Crew Wizard.  When assigning a crew member to 
a project, either use the default title and department, or select a different 
title and department for that specific project only. 

A single crew member can have many different titles on many different 
projects. 

7.4-2 Printing and Sorting Crew Member Reports 
To print a Crew Member Report, click Print or select Print from the File 
menu. Select the Current Project Crew Report. Gorilla can print a list 
with phone numbers, or a list with phone numbers and address. 

To specify the sort, go to the Crew 
Preferences Screen. To do this, click Admin 
on the Main Menu, and then click 
Preferences. Select the Crew tab. 

Under Crew Reports, there are options 
available for sorting these reports. 

  

Gorilla can sort by Department ID, Department Name, Last Name, Crew Title, 
or Custom Sort Order. 

Sorting Crew by Custom Sort Order 

To sort crew members by a custom sort order, do the following: 

1. Click the Wizard Tab.   

2. In the Re-Sort column, specify a number. If a field is 
empty, the corresponding record will sort to the top of the 
list. 

 

7.4-3 Profit Sharing 
To assign profit sharing to a crew member, do the following: 

1. Click the Projects tab.  
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2. In the Projects This Crew Member Is Attached To column, 
click the Profit Sharing checkbox. 

Now this crew member is eligible for profit sharing. To learn more about profit 
sharing, see Section 11 Distribution of Profits. 

7.4-4 Importing Crew Members 
Gorilla can import a list of crew members from Word® or Excel®. For this to 
work properly, each record must be separated by a paragraph return in Word or 
be in a different row in Excel. Prepare the data in the following order: 

1. First Name 

2. Last Name 

3. Default Title 

4. Company 

5. Default Department ID 

6. Vendor Category 

7. Type 

8. Address 

9. City 

10. State 

11. Zip 

12. Phone: Office 

13. Phone: Home 

14. Phone: Mobile 

15. Fax 

16. E-Mail 

17. Website 

18. Agent 

19. SS#/Fed ID# 

20. Notes 

21. Age 

22. Hair Color 

23. Special Skills 

24. Credits 

25. Height  

26. Weight 

27. Eye Color 

If an entry does not exist for a certain category, leave that field empty with a 
tab (Word) or an empty cell (Excel). 

After preparing the data, do the following: 

1. Select Import from the File Menu. 

2. Select Crew.  
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3. Select the type of file from the Show Available pop-down menu.  

4. Locate the file to import.  

5. Click Import. 

6. Attach the new crew members the appropriate projects.  

7.4-5 Exporting Crew Members 
To export crew members, click Export and select Crew.  

Gorilla can export the crew data the following ways: 

• Tab-Separated Text 
• Comma-Separated Text 
• SYLK 
• DBF 
• DIF 
• WKS 
• BASIC 
• Merge 
• HTML Table 
• FileMaker Pro 
• XML 

7.5 Scheduling Crew 

7.5-1 Setting Crew Call Times 
After creating shoot days (see Section 9.3 Shoot Days), the crew call times can 
be set. 

1. From the Crew Module, click . 

2. Select a shoot day and click OK. 

The Schedule Crew Screen will open.  

3. Enter a standard crew call time.  (Individual crew call times can be set 
later.)   

4. To attach all existing crew members to a specific shoot day, click 
Import Active Crew. 
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7.5-2 Adding a Crew Member to a Shoot Day 
To add crew members to a shoot day individually, do the following: 

1. Click Scheduling on the Main Menu, and select Shoots Days/Call 
Times.  

2. On the desired shoot day row, click Crew (under the Crew Call Times 
column). 

3. The Schedule Crew Screen will appear.  Click .  

4. Select the crew member and set his or her call time. 

 Important Note: Only crew members tagged as active on the Crew Screen 
can be added to shoot days. By default, all new crew members are tagged as 
active. 

Adding Notes to Shoot Days 

Notes can be added on the Schedule Crew Screen that will appear on a Crew 
Call Report. This report is explained in Section 9 Scheduling. 

Removing Crew Members from Shoot Days 

To remove a crew member from a specific shoot day, go to the Schedule Crew 
Screen and click . This will remove the crew member from that shoot day 
only.  The crew member can still be scheduled on a different day down the 
road. 

To remove all the crew members from a shoot day, click Delete 
on the Toolbar. 

Once again, this will remove crew members from that shoot day 
only. It will not delete the crew member from the system. 

Delete
 

This feature is useful if multiple crew members have been added after 
importing the active crew for that shoot day. In this way, the current crew 
members attached to that day can be quickly deleted, and then the new, 
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larger set of current active crew members can be re-imported.  However, 
individual crew call times will have to be reset.  

7.6 Other Contacts and Vendors 
Gorilla can organize vendors and contacts, store notes, attach categories to 
vendors, store phone and e-mail information, attach contacts and vendors to 
profit sharing, and print detailed reports. To utilize these features, click 
Contacts on the Main Menu. Click Vendors or Contacts, depending on what 
type of information is being stored. 

7.6-1 Adding Vendor Categories 
Gorilla comes with dozens of pre-set vendor categories. To add or modify 

vendor categories, click value list .
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The Calendar Module works in conjunction with the Scheduling Module to 
specify shoot days for projects. However, the calendar can also be used to 
record other events, such as rehearsal sessions, location scouts, script 
meetings, production meetings, and editing sessions. 

Gorilla can print a datebook report of events in a report form or a calendar-
display form. 

8.1 Attaching Events to the Calendar 
To start using the calendar, click Calendar on the Main Menu. There will be 
the following options: 

• Calendar 
• Datebook 
• Rehearsals 
• Other Meetings 

Click Calendar. By default, Gorilla will display today’s date. To navigate to 
another month or year, click the navigational arrow buttons to the side of the 
month and/or year. 

Click the desired date in the calendar. The following message will appear: 

 

Select an event from the pop-down list.  

 Important Note: To add or modify events to this list, go to Value Lists, 
accessible by clicking Admin on the Main Menu. 

Select an event from the list and click OK. 

Unless Rehearsal is selected, the Other Meetings Window will appear. The 
event and the date are already entered. The following fields can be set: 
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• Session 
• Start Time 
• End Time 
• Location 
• Address 
• Notes 

8.2 Viewing Events on the Calendar 
Upon returning to the calendar, the event created will appear on the screen. If 
the event is clicked, the Daily View Screen will appear.  On this screen, either 
add more events to that date or go to the detail view of an event. 

8.3 Printing Events  
To print events in a datebook format, click Print. There are three options: 

• Calendar – prints events in a calendar view 
• Datebook – prints events in simple datebook view/summarized 
• Events - prints events in simple datebook view/detailed 

8.4 Rehearsal Sessions 
A rehearsal session is set up just like any other event. The difference is that 
characters (cast members) can be attached to a rehearsal session and printed 
out on rehearsal session reports. 

To set up a rehearsal session, do the following: 

1. Click Calendar on the Main Menu. 

2. Select a date.  

3. Set the event to Rehearsal. 

4. Set up the session on the Rehearsal Screen. 

Set the time and location for the rehearsal session in the fields indicated. 
Indicate a session number and specify the scenes to be rehearsed during the 
session. Finally, attach cast members to the session. 

 Important Note: Only cast members (characters) that are attached to the 
current project can be attached to rehearsal sessions. 
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To attach a cast member to the session, click the 
 above the Cast Members for Rehearsal Session 

Window. Select a character.  

  

To the left of this window is the Rehearsal Sessions Window, which displays all 
existing rehearsal sessions for the current project. To navigate through the 
rehearsal sessions, click Session ID. 

To view the information for a cast member who is attached to the rehearsal 
session, clicking the . 

 Important Note: Sometimes the time and location of a rehearsal session 
will not be visible on the Rehearsal Screen until after running a Rehearsal 
Sessions Report. 

8.4-1 Viewing Rehearsals by Character 
In the Characters Module, click Rehearsals on the Gray Command Bar.  This 
screen will display rehearsals by character.  The following can be entered here: 

• Time Actor Needed 
• Confirmed 

Although the time for the rehearsal session is set elsewhere, if a specific cast 
member has a different call time than the other actors, that time can be set 
here. 

If the cast member has been confirmed for the session, select confirmed.  

8.5 Rehearsal Session Reports 
There are two Rehearsal Session Reports: 

• Rehearsal Sessions 
• Actor Rehearsal Schedule 
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9.1 Overview 
The Scheduling Module is used to create shoot days, breakdown a script, 
schedule scenes to shoot, and run call time, scene, and other related 
scheduling reports. 

9.2 Production Phases 
Production Phases can help spread a shoot across multiple weeks or months 
with breaks between them. A separate production phase can be created for 
each shoot even though that shoot is tied to the entire production. Production 
Phases have the following additional benefits: 

• Ability to run many of the scheduling reports by production phase or by 
project. 

• Ability to attach breakdown sheets to different production phases. 

• Ability to run a Day out of Days separately for each phase. 

 Important Notes There must be at least one production phase per 
project. A production phase must have shoot days.  A production phase may 
not be deleted if breakdown sheets are attached to that phase; the breakdown 
sheets must be deleted or attached to a different production phase first. 

9.2-1 Creating Production Phases 
In order to create production phases, click Scheduling on the Main Menu, and 
then click Shoot Days/Call Times. 

 

Click New and select a production phase from the pop-up list. 
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To add, modify, or delete the names in this list, go to the Value List for 
Production Phases (See Section 16.2 Value Lists). 

After selecting a phase for the first time, and if breakdown sheets exist for this 
project, click OK to attach all these breakdown sheets to this production 
phase. 

 Important Note: In order for a breakdown sheet to appear as a strip to 
be scheduled, it must be attached to a production phase. 

9.2-2 Selecting a Default Production Phase 

To force Gorilla to default to a certain production phase, select  next to 
the desired phase.  This will bypass the Select Production Phase Window while 
entering the Scheduling Module. 

To change the default, click  on the Shoot Days Screen.  

9.2-3 Manually Attaching a Production Phase to a Breakdown 
Sheet 

Each breakdown sheet must be attached to a production phase for it to be 
scheduled on the stripboard. To attach a breakdown sheet to a production 
phase manually, do the following: 
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1. Go to the desired breakdown sheet. 

2. Select an existing production phase from 
the Prod. Phase field. 

 

This can also be accomplished in List view, 
where it is more convenient to quickly scroll 
down a list of all breakdown sheets and modify 
the production phase for each one. 

 

 

9.2-4 Modifying a Production Phase for Multiple Breakdown 
Sheets 

To attach a production phase to multiple breakdown sheets at once, do the 
following: 

1. Find the desired group of breakdown sheets by using the Find command 
or the Omit button in List View. 

2. Click  on the bottom of the screen (only available if the 
Mini-Strips preference is turned on). 

3. Select a production phase to attach to these breakdown sheets. 

 

9.2-5 Set Current Production Phase 
If a project has multiple production phases, Gorilla can switch from one phase 
to another at any time. 

 Important Note:  While working in a production phase, ALL breakdown 
sheets for the entire project are accessible on the Breakdown Sheets Screen. 
However, only strips from within that production phase will be visible for 
scheduling on the Stripboard. To schedule strips for a different production 
phase, switch to that production phase. 
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To switch production phases, do the following: 

1. On the Shoot Days Screen, click . 

2. Click the  next to the desired phase. 

9.2-6 Find Breakdown Sheets with a Production Phase 
Attached 

To quickly find breakdown sheets attached to a particular production phase, 
click the  next to the production phase name on the bottom of the 
breakdown sheet. 

This can also be accomplished by clicking Find on the Toolbar. 

9.2-7 Moving All Breakdown Sheets From One Phase to 
Another 

To move all the breakdown sheets attached to one phase to another existing 
phase, do the following: 

1. Select  next to the desired phase. 

2. Select  next to the desired phase.  The breakdown sheets will be 
moved to this phase. 

3. Click . 

This is a good way to “empty” a phase before it is deleted. 

9.3 Shoot Days 

9.3-1 Creating/Modifying Shoot Days 
To create shoot days for a project: 

1. Click Scheduling on the Main Menu. 

2. Click Shoot Days/Call Times. 

3. Choose a production phase. 

4. Select the Project Start field. 

5. Enter the first day and last of shooting by clicking the appropriate date 
on the pop-up calendar. 
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Even if the last day is not yet known, enter an approximate date, as this date 
can be changed at any time. 

 Important Note: Shoot days are created for a production phase. Every 
production phase requires a new range of shoot days. 

9.3-2 Setting Off Days, Travel Days, and Holidays: Grid View  
To set an off day, travel 
day, or holiday, click the 
appropriate column on the 
day in the shoot days grid. 

Unless a travel day is 
specified as an off day, a 
shoot day can be 
scheduled on a travel day. 

 

When setting an off day, travel day, or holiday, the shoot days will update to 
reflect which days are shoot days vs. off days. A shoot day will have the shoot 
day number indicated, while an off day or holiday will have a dash (-). 

This preference can be turned off by de-selecting .  
The advantage of turning off this preference is that the screen will not redraw 
every time a change is made, speeding up Gorilla. 

 

If this preference is turned off, to manually update the shoot days to reflect 
the current view, click Edit on the Command Bar and select Update Shoot 
Days. 
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9.3-3 Shifting Shoot Days 
If a shoot is moved a few days back or forward, the shifting shoot days feature 
is an easy way to make this change.  To shift all shoot days, do the following: 

1. Select Shift All Shoot Days from the File Menu on the command 
bar. 

2. Enter the number of days the shoot is to be shifted.  Use a negative 
number to make the shoot start earlier. 

9.3-4 Setting Off Days, Travel Days, and Holidays: Calendar 
View  

To set shoot days in calendar view, do the following: 

1. Go to the Shoot Days Screen. 

2. Click Calendar View. 

3. Select a shoot day and choose an option for that day. 

 

 Important Note: Shoot days cannot be added or deleted in Calendar 
View.  However, off days, travel days, and holidays can be assigned, and 
changed back to shoot days. 

9.3-5 Printing the Shoot Day Calendar 
To print shoot days in a calendar view, do the following: 

1. Go to the Shoot Days Screen. 

2. Click Calendar View. 

3. Click Print  on the bottom of the screen. 
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4. Enter the desired month and year. A 4-month calendar can be printed on 
one page. 

9.3-6 Modifying Shoot Days 
To modify the shoot day range, do the following: 

1. Go to the Shoot Days Screen. 

2. Click either Add on the toolbar, the Project Start field, or the End 
Field. 

3. Modify the date range. 

 Important Note:  When modifying the date range, all shoot dates are re-
entered from scratch. This will delete your call times, and may take a few 
minutes.  If you have call times, it is better to add days, remove days, and 
shift days as described below. 

Add Next Shoot Day 

To add a shoot day to 
the end of your shoot, 
click File on the 
command bar and 
select Add Next 
Shoot Day. 

 

 

Remove Last Shoot Day 

To Remove the last shoot day from your shoot click File on the command bar 
and select Remove Last Shoot Day. 

Shift All Shoot Days 

To move all your shoot days to another block of time, do the following: 

1. Click File on the command bar and select Shift All Shoot Days. 
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2. Enter a positive number that represents how many forward to push the 
shoot, or a negative number to represent how many days earlier the 
shoot will begin. 

9.3-7 Setting Crew and Cast Call Times, Notes, Call Sheet 
Info, and Daily Production Report Info 

Crew and cast call times, notes, call sheet info, and daily production report 
info can be set for each day by clicking the appropriate column for the desired 
shoot day. 

 

Cast Call Times 

To set cast call times, do the following: 

1. Arrange the stripboard, and make sure that there is an end-of-day break 
at the end of the stripboard. 

2. Click Scheduling on the Main Menu, and select Shoot Days/Call 
Times. 

3. Click  for the desired day.  The actors scheduled on the stripboard for 
that day will appear. 

4. Enter a general call time in the header. 

5. Click  to make the time in the header the call time for all the actors. 

6. Set individual call times if necessary by clicking the desired time. 

The Auto Update Call Times option should remain checked.  It transfers call 
times to a new stripboard scenario after a switch. Only uncheck this if the 
schedule is locked. 

Exhibit G 

The Screen Actors Guild may require an Exhibit G for each day of shooting.  To 
enter information in the Exhibit G from the Cast Call Times Screen, click . 

Exhibit G Fields will appear in the following reports: 
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Scene/Cast Call Sheet: 
Makeup 
On Set Call Time 
Remarks 
 
Exhibit G: 
Makeup 
On Set Call Time 
Dismiss On Set 
Dismiss Makeup 
Breakfast Out 
Breakfast In 
1st Meal Out 
1st Meal In 
2nd Meal Out 
2nd Meal In 
MPV L 
MPV W 
Leave for Location 
Arrive on Location 
Leave Location 
Arrive at Studio 
Stunt Adj 
Force Call 
Actors Signatures 
 

 

 

Crew Call Times 

Crew Call Times are covered in Section 7.5-1 Setting Crew Call Times. 

Notes 

Notes can be entered for each shoot day.  There is also an option to include 
notes for the entire phase, and the entire project (Header Notes). 

Notes print on the following reports: 

1. Crew Call Summary 
o Notes 
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2. Scene/Cast Call Sheet 
o Notes 
o Header Notes 

3. Shooting Schedule by Scene 
o Notes 
o Header Notes 
o Production Phase Notes 

4. Art Department Report by Scene 
o Notes 
o Header Notes 
o Production Phase Notes 

Call Sheet Misc 

Click Call Sheet Misc to view the following screen: 

 

This information will appear on the Scene/Cast Call Sheet.  

Daily Production Report 

The Daily Production Report (DPR) is an industry standard post-shoot-day 
report.  Enter figures from the last day of shooting here. 
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Copy DPR 

To copy DPR information from one day to another, do the following: 

1. ON the DPR Screen, click  on the Command Bar. 

2. Select the shoot day to which to copy the information. 

9.4 Breakdown Sheets 
A breakdown sheet lists all of the information that pertains to a scene.  This 
includes all of the characters, props, stunt, and other elements necessary to 
shoot that scene.  

9.4-1 Adding Breakdown Sheets Manually 
To add breakdown sheets manually, do the following: 

1. Click Scheduling on the Main Menu. 

2. Click Breakdown Sheets. 

3. Click Add. 

4. Begin entering breakdown sheet information for the scenes. 
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Fields in the Breakdown Screen 

The Breakdown Screen has the following fields: 

Fields in the Breakdown Screen 

Field Description 

I/E* INT (interior) or EXT (exterior). 

Scene#s* Scene number or numbers. 

Synopsis A short description of the scene. This will appear on 
the stripboard. 

Location The location where the scene will take place. 
Locations are entered in the Location Module and 
connected to scenes here. 

Prod. Phase The production phase attached to the current 
breakdown sheet. 

Sequence Text field. 

Set* Where the scene takes place. 
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Fields in the Breakdown Screen 

Field Description 

Script Day The day in the story the scene takes place 

D/N* The time of day the scene takes place. Use one of the 
following: 
DAY 
NIGHT 
MORNING 
EVENING 
DUSK 
AFTERNOON 
SUNRISE 
SUNSET 
MIDNIGHT 
OTHER 

Pages* Number of pages for the scene. The industry standard 
is to break the page into eighths. 

Sheet#* Breakdown sheet number. If there is one scene per 
breakdown sheet, these numbers should correspond to 
the scene number. If there is multiple breakdown 
sheets per scene, they can differ. 

End of Day The shoot day. This date is scheduled on the 
stripboard. 

Script Page* The page number where the scene starts in the 
screenplay. 

Categories Categories to which elements are attached. This helps 
in organizing elements. Gorilla comes with 21 pre-set 
Categories.  

Available Element Elements that are available to use for the specified 
category. 

ID Character ID field (Scheduling ID). 

*Information that can be imported from Final Draft and Movie Magic 
Screenwriter. 

9.4-2 Duplicating a Breakdown Sheet 
In order to duplicate a breakdown sheet, click Breakdown on the command 
bar and then select Duplicate Sheet. 
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Now, the new breakdown sheet can be customized as needed for the next 
scene. 

9.4-3 Splitting a Breakdown Sheet 
Splitting a breakdown sheet is the same as duplicating a breakdown sheet, 
except that the breakdown sheet can be duplicated 2 – 7 times, and the split 
breakdown sheets are all linked together. This is useful if a scene is to be 
spread over a period of more than one day and multiple strips on the stripboard 
are required for this purpose. 

To split a breakdown sheet, do the following: 

1. Click Breakdown on the command bar and then select Split Scene.  

2. Specify how many days over which the scene is to be split (from 2 to 7 
days). 

The breakdown sheet will be duplicated. An orange dot will appear next to all 
split scenes when viewing scenes in the List View. 

9.4-4 Removing a Split from a Breakdown Sheet 
To remove a split from a breakdown sheet, do the following: 

1. Navigate to the split breakdown sheet.  Split breakdown sheets are 
indicated with the following:  . 

2. From the Breakdown Menu on the Command Bar, select Remove 
Split. 

9.4-5 Deleting Multiple Breakdown Sheets 
In order to delete multiple breakdown sheets quickly, do the following: 

1. Click 
List

 on the Toolbar. 

 

2. SHIFT-CLICK 
Delete

 on the Toolbar. 

 

The Breakdown Sheet Maintenance Screen will appear, shown below: 
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3. By clicking the  button next to a breakdown sheet line item, the 
breakdown sheet will be immediately deleted (and consequently the 
related strip on the Stripboard). 

There will not be a delete warning, so be careful! 

4. Click 
Return

 to return to the Breakdown Screen. 

 

Another Way to Delete Multiple Breakdown Sheets  

The following is another method for deleting multiple breakdown sheets: 

1. Click List on the Breakdown Screen Toolbar. 

2. SHIFT-CLICK Delete on the Breakdown List Screen Toolbar. 

The Breakdown Sheet Maintenance Screen will appear  

3. Click the checkbox in the Tag for Delete column for all breakdown 
sheets to be deleted.  

4. Click Delete on the Toolbar. 

5. All tagged breakdown sheets will be grouped and displayed. They are not 
yet deleted.   

6. SHIFT-CLICK Delete again.  The following message will appear: 
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7. Click OK. 

8. Click Return to return to the Breakdown Screen. 

9.4-6 Adding Elements to a Breakdown Sheet 
Elements are items that are scheduled onto breakdown sheets so that the 
Production Designer, Costumer, Prop Master, Set Dresser, etc., know what to 
prepare for that day of shooting. 

Adding a Cast Member to a Breakdown Sheet 

 

1. Select Cast Members from the Categories Window. 

2. All available cast members (characters) will appear in the middle 
Available Cast Members Window. 

 Important Note:  If a cast member is not visible here, yet exists in the 
Character Module, this character must be converted to a breakdown element. 
(See Section 9.6-8 Import Cast: Convert from Characters to Elements). 

3. Select the desired cast member. 

4. The cast member will appear on the right Cast Members for this 
Breakdown Sheet Window. 

Adding a Non-Cast Member to a Breakdown Sheet

Adding other elements such as 
Props or Costumes to a 
breakdown sheet is similar to 
adding cast members.  

To add props to a breakdown 
sheet, do the following:  
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1. Select props from the Categories Window. 1. Select props from the Categories Window. 

2. All available Props will appear in the middle Available Props Window. 2. All available Props will appear in the middle Available Props Window. 

3. Select the desired prop. 3. Select the desired prop. 

The prop will appear on the right Props for this Breakdown Sheet Window. The prop will appear on the right Props for this Breakdown Sheet Window. 

Creating a New ElementCreating a New Element 

To create a new element, do the following: 

1. Select the appropriate category for the new element. 

2. Click  on the middle window. 

3. Enter the name of the new element in the Element Name field. 

4. Click Add to create more elements. 

5. Click Done when finished. 

 

If the Add Element to Current Breakdown Sheet Checkbox is selected, this 
element will be automatically added to the current breakdown sheet. 

To create elements in this manner and not have them 
automatically attached to the current breakdown 
sheet, deselect this checkbox.  

Sorting Elements 

When creating breakdown sheets, sometimes a different sort order will help 
when viewing all the available props or cast members to choose from. These 
lists can get very large. (See Section 9.6-4 Hiding Elements).  To change the 
sort order of the middle Available Elements Window, click  (located on the 
top/middle of that window).  The available elements can be sorted by ID or by 
name. 
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Example A: Props sorted by NAME. 

 

Example B: Cast Members sorted by ID 

 

In the above two examples, it makes more sense to sort the Cast Members by ID 
because the lead characters are used more often than the others. However, it 
makes more sense to sort props alphabetically by name. 

Filtering Elements 

Elements can be filtered by their first letter.  To do this, click Show All.  
Choose from the list of letters. 

To show all the elements again, click Show and choose All. 

Adding Elements to Multiple Breakdown Sheets 

To quickly add a single element to multiple breakdown sheets, do the 
following: 

1. Click the Elements Tab. 

The Elements Screen will appear.  This is good place to locate elements.  
Buttons on the right will filter your elements by the various groups.  

 

2. Click the  next to the desired element. 

The Element Detail Screen will appear (See Section 9.6-3 Element 
Preferences).  This is a good place to keep notes about each element. 

3. Click the Breakdown Sheets Tab. 
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A list of breakdown sheets to which this element is attached will appear. 

4. Click the  and choose more breakdown sheets from the complete list 
of breakdown sheets.  

5. Click Done. 

9.4-7 Character ID’s 
The number next to the cast member is the scheduling ID for that cast 
member. 

On the bottom of the breakdown sheet 
there is an ID field.   

The numbers that are in the field correspond to the Character ID’s for the Cast 
Members that are scheduled for that breakdown sheet. These numbers also 
appear on the stripboard. 

To manually update the numbers in the Character ID field to reflect what is 
scheduled on the breakdown sheet, click the black arrow  in front of the ID 
label. 

9.4-8 Updating Character IDs 
Character IDs that have been changed manually can be updated to reflect what 
is scheduled on the breakdown sheet.  To update character IDs, do the 
following: 

1. Click . 

2. Choose either to update the current breakdown sheet, or all the 
breakdown sheets in the currently found set. 

9.4-9 Viewing Breakdown Sheets in List View 

To view breakdown sheets in a list view, click . 

 

This makes it easier to view breakdown sheet information. To sort the 
breakdown sheets, click an underlined title of the appropriate column. In the 
example above, the list is sorted by scene number, indicated by the blue and 
underlined Scene #. 
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Information can be edited in this layout as well. 

To view a breakdown sheet, click the  corresponding to the appropriate row. 

To remove a row from the list view, click .  The row will not be 
deleted. 

9.4-10 Mini-Strips 
The mini stripboard, seen to the right 
of the breakdown sheet, corresponds 
to the stripboard. 

Click on a strip in the mini-stripboard 
to navigate to that breakdown sheet. 

 Important Note:  Mini-strips will 
correspond to the currently chosen 
stripboard sort order.   

The red highlighted strip is the strip/breakdown sheet currently in view. 

A black end-of-day strip indicates a day break. 

Mini-strips can be hidden by setting a preference on the Breakdown 
Preferences.  The inclusion of scene numbers on the mini-strips can turned on 
or off here as well.  (see Section 16.1-5 Breakdown Preferences) 

9.4-11 Viewing/Printing Printable Breakdown Sheets 
To view and print 
breakdown sheets, 
select Preview 
Breakdown Sheet 
from the Breakdown 
Menu on the Command 
Bar. 

Breakdown sheets can 
be printed in 5 ways. 
They are as follows: 

 

 

1. 1-Page Standard boxed breakdown sheets (18 categories per page/5 
pages max. per sheet) 
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2. 2-Page Standard boxed breakdown sheets (21 categories per 2 pages/10 
pages max. per sheet) 

3. 3-Page Standard boxed breakdown sheets (21 categories per 3 pages/15 
pages max. per sheet) 

4. Shooting Schedule Report by Day 

5. Shooting Schedule Report by Scene 

Furthermore, the Shooting Schedule Reports can be sorted by either Element ID 
or Element Name and customized as to where the page break occurs – either by 
day or by scene.  

 

To navigate from one breakdown sheet to the other, 
click Next Breakdown or Prev Breakdown. 

To navigate to the next page of the current breakdown 
sheet, click Next Page. Not all breakdown sheets will 
have more than one page. 

To print the current breakdown sheet, click Print 
Sheet. 

To print all the breakdown sheets for the current 
project, click Print All. 

 

 

 

Switching from 1-, 2-, and 3- Page Sheets 

To switch from 1-page, 2-page, and 3-page breakdown 
sheets, click the appropriate button. 

 

 

The blue box indicates the current view.  2-page and 3-page breakdown sheets 
allow more room for elements than the 1-page breakdown sheet. 
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Swapping breakdown sheet boxes 

It may be a good idea to swap boxes if a box is always full. 

 

For example, in the breakdown sheet above, the category Costumes has more 
items than the category Props.  In fact, the list of costumes might continue 
onto the next page. To maximize space and to eliminate wasted paper, the 
Costumes box and the Props box can be swapped, allowing more room for 
costumes. 

To swap a breakdown sheet box, do the following: 

1. Click Swap Boxes. 

2. Click the Costumes box. The title will turn 
red. 

3. From the list of categories shown on the 
right-hand side of the screen, select 
Props. 

4. Repeat this procedure for the Props box.  

Assigning an empty box 

When swapping breakdown sheet boxes, it is not a 
good idea to have two or more boxes assigned to 
the same category. This will cause confusion both 
visually and administratively.  To make the box 
empty (no title and no elements), use the Swap 
Boxes feature and select Set Category to 
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Empty. 

 

Resetting breakdown sheet boxes 

To reset breakdown sheet boxes to the default setting, click Set Default 
Boxes. 

Adding Elements Directly onto a Breakdown Sheet 

To add elements directly onto a breakdown sheet, 
click the appropriate category. For example, if the 
Props box is clicked, the screen to the right will 
appear. 

Select any element from the Pick Props Screen and 
it will be added directly onto the printable 
breakdown sheet. 

Using this method to add elements to the 
breakdown sheets is slower than adding them from 
the Breakdown Sheet Screen.  

 Important Note:  An element can only be 
added to a breakdown sheet on this screen.  An 
element cannot be removed, created, or deleted. 

 

To add another element to the breakdown sheet from another category, click 

that category.  To return to the Printable Breakdown Sheet Screen, click . 

Printing Blank Breakdown Sheets 

To print a blank breakdown sheet, click Print Blank. 

Breakdown Sheet Print-Outs vs. Summary Reports 

Breakdown sheets are an industry standard and were designed by production 
designers before there were computers. Gorilla prints standard breakdown 
sheets, but Gorilla also prints elements in a Category List or in a Shooting 
Schedule Report that is more efficiently designed. Compare all three ways and 
decide which one is best for you.  

9.4-12 Importing Breakdown Sheet Information from a 
Screenplay Program 

Gorilla can import breakdown sheet information from the following sources: 

• Final Draft 
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• Movie Magic Screenwriter 

This procedure is covered in Section 6.2 Importing Characters and Breakdown 
Sheets from a Screenplay Program.  Please read that section carefully, 
especially the information about Preparing the Screenplay. 

9.4-13 Re-Importing a Script 
Following major screenplay revisions, it may be appropriate to re-import the 
data from the screenplay.  The first step is to delete the current scheduling 
data to avoid doubling the scenes, characters, props, etc. 

Deleting the Old Schedule 

To delete the old schedule, do the following: 

1. Make sure the appropriate project is current (See Section 5.1-3 
Switching Project). 

2. Select Delete Scheduling from the Tools Menu of the Command 
Bar, or navigate to the Save/Load Screen from the File Menu.  

 

3. Click . 

9.4-14 Renumbering Scenes 
To change the scene numbers from the ones that were imported from a script, 
modify the Scene Number Field on each breakdown sheet.  If there are many 
scenes to renumber, it will be quicker to modify scenes numbers in list view 
(See Section 9.4-5 Deleting Multiple Breakdown Sheets).   

Gorilla also has an auto-renumber feature.  To automatically renumber scenes, 
do the following: 

1. Use the Find command (click Find on the toolbar) to find the group of 
breakdown sheets that are to be renumbered. 
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2. Use the Sort command (click Sort on the toolbar) to sort the breakdown 
sheets in the new order. 

3. Select Renumber Scenes/Sheets from the Tools Menu on the 
Command Bar.   

4.  Select Replace with Serial Numbers, and increment by 1. 

5. Click Replace. 

9.5 Categories 
Categories are groups to which elements belong. Gorilla has 21 pre-set 
categories for use on breakdown sheets. They are: 

1. Cast Members 
2. Extras 
3. Stunts 
4. Vehicles 
5. Props 
6. Special Effects 
7. Costumes 
8. Makeup 
9. Livestock 
10. Animal Handler 
11. Music 
12. Sound 
13. Set Dressing 
14. Greenery 
15. Special Equipment 
16. Security 
17. Additional Labor 
18. Optical FX 
19. Mechanical FX 
20. Miscellaneous 
21. Notes 

To access these categories, do the following: 

1. From either the Breakdown Sheet Screen or the Main Menu/Scheduling, 
click Categories. 

2. To view related elements for each category, click the category name. 
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The elements that belong to the highlighted category will appear on the right. 

9.5-1 Modifying Category Names 
Gorilla is limited to having 21 categories, but the names of these categories 
can be modified, except for Cast Members and Props. 

To modify a category name, click the black arrow next to the appropriate 
category.  

 

Select from the pop-down list of all available category names.  To create a new 
category name, do the following: 

1. On the Categories Screen, click Value List . 

2. Click  and add a new category. 

3. When finished, click Done to close the window. 

The new category(s) created will now be available.   

9.5-2 Adding Elements from the Categories Screen 
The Categories Screen is a great way to add elements. To quickly view what 
elements are already attached to which categories, click a category name in 
the left window. 

Elements can be displayed alphabetically or by their Element ID/Scheduling ID. 
For cast members this will be the Scheduling ID while for other elements this ID 
will correspond to the order the elements were created. To change the sort 
order, click Sort . 

To add an element on this screen, do the following: 

1. Click the appropriate category. 

2. Click the  above the elements column on the right. 

3. The Add Elements Window will appear. 

4. Enter the name of the new element.   
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5. Click Add.  Continue adding elements to this category as necessary. 

6. Click Done. 

9.6 Elements 
Elements are characters or items used to breakdown a screenplay. If a scene 
has a character and the character picks up a pencil and places it on a table, 
that scene has three elements: The character, the pencil and the table.  

Each element is associated with a category. In the example above, the 
relationship to categories would be as follows: 

Example of Elements and Their 
Related Categories 

Element Category 

Character Cast Member 

Pencil Prop 

Table Set Dressing 

Categories are customizable (see Section 9.5-1 Modifying Category Names). 
Elements are specific to a project.  

 Important Note: Elements can be shared from one project to another. 
See Section 9.6-5 Copying an Element to Another Project.  

There are two ways to access the Elements Screen: 

1. Click Scheduling on the Main Menu and then click Elements. 

or 

2. From any scheduling screen, click the Elements Tab. 

On the Elements Screen, view elements by selecting a category on the right 
side of the screen. 

9.6-1 Renaming an Element 
To modify an element name, select the element and rename it. 

9.6-2 Deleting an Element 
Select the element and click . 
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 Important Note: Warning! Deleting an element will deleted it from all 
parts of the project, including breakdown sheets. 

9.6-3 Element Preferences 
To modify preferences for a particular element, do the following: 

1. From either the Categories Screen or the Elements Screen, find the 
desired element and click . 

2. The Element Detail Screen will appear, where the following preferences 
can be set: 

Preferences for Elements 

Preference Description 

Allow Holds If checkmarked, when running a Day out of Days Report, this 
element will hold for the number of days indicated in Days 
Held before Drop. 

Allow 
Drops/Pickups 

If checkmarked, this element will drop and then pickup in the 
number of days indicated in Days Held before Drop. 

Drop to Use Specify a number (by default set to 1) which will indicate 
which drop to use if the element is eligible to be dropped more 
than once. 

Days Held 
before Drop 

Specify a number (SAG rules dictate 10-14) which specify how 
many days an element is held before dropped. 

Day out of Days Example 

If the character MARY is scheduled to shoot on the following days: 

04/01/2006 
04/02/2006 
04/05/2006 
04/11/2006 
04/24/2006 

And her element preferences are set to the following: 

Allow Holds = x 
Allow Drops/Pickups = x 
Drop to use = 1 
Days Held before Drop = 10 

After running a Day out of Days Report, her report would like this: 
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4/1 4/2 4/3 4/4 4/5 4/6 4/7 4/8 4/9 4/10 

SW W H H W H H H H H 

 

4/11 4/12 4/13 4/14 4/15 4/16 4/17 4/18 4/19 4/20 

WD          

 

4/21 4/22 4/23 4/24 

   PWF 

Explanation of above matrix: 

On 4/1 Mary begins shooting, so her legend is SW which stands for START 
WORK. She returns the next day, which is 4/2 so that box is tagged with W, 
which stands for WORK. She does not return until 4/5, which is three (3) days 
later. Since we are allowing HOLDS for Mary, we need to hold these days, 
which are signified with an H. The next day she works is 4/11, which is 6 days 
later. Since we do not attempt to drop her unless she is not working for 10 
days, these days are also held. After 4/11, Mary does not work again until 
4/24, which is also her last day of work. Since this span is more than 10 days, 
we drop her on 4/11, signified with a WD (WORK DROP), and then have her 
picked-up on 4/24, signified with a PWF (Pickup/Work/Finish). 

Art Department Details for Elements 

The Production Designer, Costumer, Set Designer, Prop Master, or any other 
member of the Art Department can enter detailed information about an 
element here. 

This is extremely useful for storing detailed information about a prop or piece 
of wardrobe for research, design, purchase, or any number of other uses. To 
enter detailed information about any element, go to the Elements Screen and 
click  the Detail column. 

The following window will appear on the lower-half portion of the screen: 
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Enter detailed information about the element, materials needed to construct 
or design that element, or notes about that element, and up to four vendors 
from which the element requires materials. 

When finished, print an Art Department Report that will summarize this 
information. 

Element Picture 

To attach a picture to any element except cast members (which use headshots 
in the Cast Module), do the following: 

1. From either the Categories Screen or the Elements Screen, find the 
desired element and click . 

2. Click  and choose the desired JPEG, GIF, or BMP file. 

Element pictures print on the following reports: 

1. Elements [Pictures] 

2. Art Department 

9.6-4 Hiding Elements 
Elements can be hidden from the Available Elements Window on the Breakdown 
Sheet Screen. 

When To Use Hide Elements 

This is useful if a production has many props, say over a hundred, and many of 
them are only used once or twice throughout the production.  In this case, it is 
best to “hide” an element that has already been scheduled so it will not be 
visible in the Available Elements Window. The remaining elements will then be 
easier to find. 

Hiding elements does not delete the element, but makes the element 
temporarily invisible. 
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To hide an element from a breakdown sheet, do the following: 

1. Go to the Elements Screen. 

2. Select the appropriate element and select the Hide checkbox. 

To unhide the element, return to the Elements Screen and uncheck Hide. 

9.6-5 Copying an Element to Another Project 
In order to reuse an element from one project to another without recreating 
the element, do the following: 

1. Go to the Elements Screen and find the desired element. 

2. Click the .  A list of projects will appear. 

3. Select the project to which the element is to be copied. 

This will not work for characters. 

9.6-6 Importing Elements from Another Source 
Gorilla can import elements from a Word list, an Excel spreadsheet, or a 
FileMaker Pro database. 

Preparing the File 

To import the elements properly, go to the source application where the 
elements reside and prepare the data as follows: 

In the figure below, a list of costumes is being imported from an Excel 
spreadsheet running on a Macintosh. 
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Prepare the elements in a single column. Each element should be on its own 
row.  Close the source application and return to the Elements Screen. 

Importing the Elements 

To import elements, do the following: 

4. Select Import from the File Menu on the Command Bar. 

 

5. Click Elements. 
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6. Select the appropriate Category.  In the example above, Costumes 
should be selected.  Click Import. 

7. Locate the file and click Open. 

9.6-7 Exporting Elements to Another Source 
To export elements, do the following: 

1. Select Export from the File Menu on the Command Bar. 

2. An Export Map will appear (See Section 2.3 Exporting). 

3. Clicking Export will export all the found elements. To export all the 
elements for all projects, click Find All and then click Export. 

9.6-8 Import Cast: Convert from Characters to Elements 
Characters that were created manually (not imported from a screenplay 
program) must be converted to elements if they are to be scheduled. 

To individually convert a character to an element, do the following: 

1. Click Story on the Main Menu and then select Characters. 

2. Click the Stats tab. 

3. Click Convert to Breakdown Element  

9.7 Storyboard 
The storyboard can help keep track of each shot needed to cover a scene.  This 
can be used for planning purposes, or to make sure that every shot has been 
captured during production.  To view the storyboard, either click Scheduling 
on the Main Menu and click Storyboard/Shot List, or click the 
Storyboard tab on any Scheduling Screen. 

To add a shot, do the following. 

1. Click . 

2. Enter the basic shot information and click OK. 

3. To enter more detailed info, click the  next to the shot. 
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9.7-1 Storyboard Detail Screen 
An example of the Storyboard detail screen is above. 

Order v. Setup Order 

Gorilla storyboards are used for both planning and production.  This is why 
there is a place to indicate both (script) order and setup order.  During 
planning, it is best to view the storyboards in script order.  During production, 
setup order is preferable.  This can be set in Shots Preferences (See Section 
16.1-11 Shots). 

Start and End Time 

Start and end time can be important for shooting live television. 

Scene Info 

This tab will display scene information from the breakdown sheet and a list of 
other shots for that scene.   

Bird’s-Eye View 

This tab will display a bird’s-eye view of the shot.  These images must be 
created in another program.  See Import Picture below. 

Script 

This tab will display the portion of the script for this shot.  Copy and paste this 
info from your script-writing program. 

Import Picture 

To import a picture or storyboard, click .  To remove one, click . 

Shot/Not Shot 

There is a place to indicate whether or not this shot is “in the can.” 
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Continuity 

Click  to reveal a screen where there is a place to import a continuity 
photo. 

9.7-2 Mutimedia 
Clicking the Multimedia tab on the Storyboard Screen will display a screen 
that allows for the import of a clip.  This clip can be a rehearsal of the scene, 
or a scene from another movie that resembles the desired scene. 

9.8 Stripboard 
The stripboard is used to rearrange scenes into shooting order. 

 Important Note: Before rearranging strips on the stripboard, complete 
the following: a) Create a production phase, b) Enter all breakdown sheets, c) 
Create shoot days, including days off and holidays. 

To access the Stripboard, click Scheduling on the Main Menu and then click 
Stripboard, or click the Stripboard tab on any Scheduling screen. 

Only strips pertaining to the phase selected will be visible. Remember: All 
breakdown sheets must be attached to a production phase.  (See 9.2 
Production Phases). 

9.8-1  Choosing a Sort Order 
It is often useful to sort the strips by one or more criteria, and to experiment 
with different sort orders using different scenarios.  To sort the stripboard, 
click Stripboard on the Command Bar and then click Sort By… 

 

Select an initial sort order for the strips by choosing from the following default 
sorts: 

• Color 
• I/E 
• D/N 
• Location 
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• Set 
• Scene No. 
• Sheet No. 
• Character 
• Pages Ascending 
• Pages Descending 

Explanation of the Default Sort Orders 

Order Description 

Color This is the color of the strip. The color of the strip is defined by 
the D/N field. (DAY, NIGHT, MORNING, EVENING, ETC.) See 
Section 9.8-10 Selecting Colors for the Stripboard for more 
information. 

I/E Interior or exterior 

D/N Time of Day 

Location This will sort by the physical location of the scene.  This feature 
works in conjunction with the Locations Module.  (See Section 
12 Locations)  Locations must be attached to each breakdown 
sheet for this to work. 

Set This is the set description entered or imported on the 
breakdown sheet. 

Scene No. Scene Number entered or imported onto the breakdown sheet. 

Sheet No. Sheet Number entered or imported onto the breakdown sheet. 

Character The Character ID entered onto the breakdown sheet. If there is 
more than one on a sheet (i.e.: 1, 3, 5, 8), this will not sort 
perfectly. 

Pages 
Ascending 

Sort by the page count, starting from the smallest number up. 

Pages 
Descending 

Sort by the page count, starting from the largest number down. 

The default sort orders help to start ordering strips in a way that will make 
sense for a particular project. For example, to shoot all the scenes together 
which are going to take place at one location (i.e STEVE’S HOUSE), sort by 
location first. On the other hand, to shoot in screenplay order, sort by the 
SCENE NO., and then begin to custom sort the strips. 

9.8-2 Customizing Stipboard Sort Order 
Strips can be re-ordered to match the requirements of the shoot.   
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1-Column, 2-Column, and 9-Column Layout  

There are three ways to view the strips:  1-column, 2-
column, and 9-column layout.  Choose from these layouts by 
clicking the layout selector on the upper-left-hand corner of 
the Stripboard Screen. 

 

 

The instructions for moving strips differ slightly depending on which layout is 
used. 

Moving Strips in 1-Column Layout 

To move a strip in 1-column layout, do the following: 

1. Click the desired strips.  The strips will turn red.  To de-select a strip, 
click it again. 

2. Alt-Click (Windows) or Option-Click (Macintosh) the strip below which 
the selected strip(s) are to be moved.   

Many strips can be selected at the same time using this method.  To move a 
block of contiguous strips, do the following 

1. Click the first strip of the desired block. 

2. Shift-Click the last strip of the desired block. 

 Important Note: Make sure to hold down the Alt Key (Windows) ore 
Option Key(Mac) until after the strip has moved.  If the key is not held down 
long enough, the strip will not move. 

Moving Strips in 2-Column Layout 

2-Column Layout is best used for moving strips from one particular day to 
another.  Each of the two columns display one day chosen from the pop-up 
menu as shown below. 
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To move a strip from the left column to right column, do the following: 

1. Click the desired strip(s) in the left column. 

2. Click the place where the strips should go in the right column.  This strip 
will turn green with an arrow pointing down. 

3. Click  

The selected strip(s) on the left will move to below the green strip on the 
right.  To make the selected strips appear above the green strips, click the 
green strip again, and the arrow will point up. 

 

Moving Strips in 9-Column Layout 

9-Column Layout displays the strips for nine different days.  Choose the days 
from the pop-up menu above each column. 

 

Strips from any column are selected by clicking them.  Alt-Click (Windows) or 
Option-Click (Macintosh) the strip below which the selected strip(s) are to be 
moved.   

9.8-3 Save/Load a Stripboard Scenario 

To save a stripboard scenario, click on the toolbar.  To save multiple 
scenarios, click Save As and rename the stripboard. 

To load a stripboard, click  on the toolbar.  Click  next to the desired 
stripboard scenario. 



Scheduling 

-83- 

9.8-4 Scrolling Up and Down the Stripboard 
In order to scroll up and down the stripboard to view and/or renumber the 
strips, click the scroll bar on the right. 

9.8-5 Adding Day Breaks 
Day Breaks can be added one day at a time, or entered all at once. 

Entering Day Breaks One Day at a Time

To the right of the stripboard is the Shoot Days 
Window. This list displays all available shoot days. 

Note: If there are no shoot days in this list, create 
them now by clicking the Shoot Days tab.  

To add the first shoot day, click . 

 

In the above example, clicking  will add the date 3/1/04 to the stripboard as 
a day break. The day break will appear at the end of your stripboard, so it may 
be necessary to scroll down to see it. 

 

Notice that the  (green) turned  
(blue).   

This indicates that this day is now set 
on the stripboard as an End of Day. 

  

 

Explanation of Buttons in the Shoot Days 
Window: 

Button Indicates/Function 

 (green) Shoot day available, not scheduled 
on stripboard 
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Explanation of Buttons in the Shoot Days 
Window: 

Button Indicates/Function 

 (blue) Shoot day already set on stripboard 

 (red) Off day or holiday. Day not 
available to set as an End of Day. 

 (orange) Adds the next available day to the 
end of the shoot day schedule.  
This is a quick and simple way to 
add a shoot day without resetting 
the entire range of shoot days.  

 

Entering Day Breaks All at Once

Gorilla can add all of the Day 
Breaks instantaneously. Select 
Add All Day Breaks from the 
Day Breaks menu on the 
Command Bar. 

The following message will 
appear: 

 

 

 

To add all of the day breaks to the end of the stripboard, click All. 
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To specify whether automatic day breaks are added at the end of the 
stripboard or at the beginning of the stripboard, go to Strips/Preferences. 

 

Notice how Gorilla did not add Sunday, July 4th, 2004 as this is specified as an 
Off Day.   

Equivilent Decimals for 
Eights 

Eighth Decimal 

1/8 .125 

2/8 .25 

3/8 .375 

4/8 .5 

5/8 .625 

6/8 .75 

To automatically enter day breaks spread 
across the stripboard using a per-day ratio 
click Auto and enter the desired number of 
pages per shoot day. To enter eighths of 
page, use the table to the right. 

When Gorilla has exceeded the desired 
number of pages, either the last scene/strip 
will stay on the current day, or be pushed to 
the next day.  This preference can be set in 
Preferences/Strips. 

7/8 .875 

 

9.8-6 Moving Day Breaks 
Day breaks move just like other strips.  However, they may get out of order.  
See the example below: 
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If this happens, choose Update Stripboard from the Stripboard Menu on 
the Command Bar.  The days will be renumbered appropriately. 

9.8-7 Removing Day Breaks 
A single end of day can be removed from the stripboard or all day breaks can 
be removed from the stripboard. 

Removing a Single Day Break 

To remove a single end of day from the stripboard, do the following: 

1. Click the Day Break(s). 

2. Select Remove Selected Day Break from the Day Breaks menu on 
the Command Bar. 

 Important Note: If a day break is removed from the stripboard, creating 
a gap in the end-of-day sequence, Gorilla will update the day-breaks in 
sequential order.  The only way to skip a day is to indicate the day as an off 
day. 

Removing All Day Breaks 

To remove all Day Breaks from the stripboard, select Remove All Day 
Breaks from the Day Breaks menu on the Command Bar. 
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Daybreaks Out of Order 

Sometimes, after moving 
strips and daybreaks around, 
the daybreaks can be out of 
order.  For example, day 2 
may appear before day 1. 

To fix this, select Update 
Stripboard from the 
Stripboard Menu on the 
Command Bar. 

 

 

9.8-8 The Boneyard 
To remove a strip from the stripboard without deleting it, send it to the 
Boneyard. The Boneyard is a place to hold strips not used in the current 
stripboard scenario.  

Moving Strips to the Boneyard 

To send strips to the Boneyard, do the following: 

1. Select the desired strips using the 1-Column Stripboard.   

2. Select Send to Boneyard from the Stripboard Menu on the Command 
Bar. 
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 Important Note: When moving a strip to the Boneyard, only the strip 
from the current stripboard scenario is moved.  

Moving Strips Back to the Stripboard from the Boneyard 

To move a strip from the Boneyard to a stripboard, do the following:  

1. Click  on the toolbar. 

2. Click the desired strip. 

9.8-9 Banners 
A banner is a note that can be placed on the Stripboard. This is useful for 
labeling a set of strips. 

Adding a Banner 

To insert a banner on the Stripboard, do the following: 

1. Click on the Toolbar or select Add Banner from the Day Breaks 
Menu on the Command Bar.  

2. Enter text for the banner. 

Modifying a banner 

To modify the text of a banner, do the following: 



Scheduling 

-89- 

1. Click the desired banner using the 1-Column Stripboard. 

2. Enter new text. 

3. Click Rename. 

Moving a Banner 

On the 1-Column Stripboard, click the banner and then click Move to select the 
banner.  The banner will then move like any other strip. 

Removing a Banner 

To remove a banner, click the desired banner using the 1-Column Stripboard 
and then click Remove. 

9.8-10 Selecting Colors for the Stripboard 

To modify the colors for the strips, click on the Toolbar. 

The stripboard is preset with the following color scheme: 

 

Strip colors are determined by the combination of the time of day the scene 
takes place and whether the scene is interior or exterior. 

To change a color for a strip, select the box from the grid so it is highlighted 
with a black box around it (Example above: The INT. DAY box is highlighted), 
and then select a color. 

To restore the default colors, click Restore. 
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9.9 Save/Load Schedule 

9.9-1 Save Schedule 
To save a schedule, do the following: 

4. Select Save/Load from the File Menu on the Command Bar. 

5. Click . 

The following are saved with a schedule file:  Breakdown sheets, Stripboard 
Scenarios, Storyboards/Shot Lists, Locations, and Cast, Crew, Vendors, and 
other contacts attached to the project. 

Schedules are saved with a .grs extension, and can be emailed to other Gorilla 
users. 

9.9-2 Load Schedule 
To load a schedule, do the following: 

1. Select Save/Load from the File Menu on the Command Bar. 

2. Click . 

3. Find the desired Gorilla schedule.  This file will have the .grs extension. 

 Important Note: Loading a schedule will replace the active schedule.  A 
schedule that has more than 48 shoot days cannot be loaded into Gorilla 
Standard or Student Edition.  A schedule with more than 14 shoot days cannot 
be loaded into Gorilla Student Edition. 
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Gorilla comes preinstalled with sample budgets which can be customized.  The 
Budgeting Module also has some powerful features like comparing two budgets 
within a project, globals, and fringes. 

10.1 Creating a Budget From Scratch 
Click Budgeting on the Main Menu and then click 
View/Create Budget. 

The Budget Selector Screen will appear. Click New 
and name the budget. 

 

 

To continue, click  next to the budget name. 

10.2 Loading a Sample Budget 
To load a sample budget, do the following: 

1. Click Load. 

2. Navigate to the Saved Budget Files Folder. 

3. Select a Sample Budget. 

10.3 The Budget Structure 
The budget is divided into three tiers. They are: 



Budget 

-92- 

1. Categories (Top Sheet) 

2. Account Level (2nd Tier) 

3. Detail Line Items (3rd Tier) 

Each category can have many accounts, and each account in turn can have 
many details. 

To navigate between these tiers, use the Budget Tier 
Indicator. 

 

A Gorilla budget begins at the Top Sheet, or Category Level. Within the Top 
Sheet there are five sections. They are: 

1. Above-The-Line 

2. Production 

3. Post Production 

4. Other 

5. Percentages 

There are two ways to view the Top Sheet. 

10.3-1 Viewing Top Sheet by Section 
To view categories by part, click the tab that represents the desired section.  
In the example below, the Above-The-Line section is selected. 

 

10.3-2 Viewing All Parts at Once 
To view all categories on one screen, click the Top Sheet tab. 
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In this view, fewer accounts per category are visible at once. Use the up and 
down arrows to see the hidden accounts. 

Custom Captions 

The captions for the budget parts can be customized.  To do this, select 
Captions for the Setup Menu on the Command Bar. 
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This is also a place to enter Crew Titles, Name and Phone Numbers that will 
display in the budget header. 

To restore default labels to all captions, click Restore. 

Expand Top Sheet View 

The top sheet view can be expanded vertically in order to allow the display of 
more line items.  To do this, select Expand Top Sheet from the View menu 
on the Command Bar.   

10.3-3 Adding a Category 
To add a category, do the following: 

1. Click  or select Add Category from the Edit menu on the 
Command Bar. 
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2. Choose a 
section. 

3. Enter a 
Category ID 
number. 

4. Enter a 
Category 
Name. 

5. Click OK.  

 Important Note: Category ID’s must be unique within a budget. Gorilla 
will not allow the same Category ID to be used twice. 

Change Category ID or Category Name 

To change a Category ID, Category Name or move a category to another budhet 
section, click the Category ID in either the Top Sheet or Section View.  The 
following dialogue box will appear: 

 

Again, a new Category ID must be unique. 

Find a Category by ID 

In order to quickly find a Category ID, select Find Category (1st Tier) 
from the Edit menu on the Command Bar.  Enter a Category ID and click 
Find.   

10.3-4 View Acccount Level 
To view the Account Level Line Items Screen, click  next to the desired 
category.  

The example below shows the account level line items for the Category 1100 – 
Development.  These accounts were imported using a Gorilla Template. 
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ACCOUNT is highlighted in the Budget Tier Indicator.  
Another way to navigate to different tiers of the 
budget is to click here:  

Notice that there are few numbers in the total column to the far right of the 
screen. This is because detail line items have not yet been entered. 

10.3-5 Duplicating an Account Level Item 
Sometimes it is useful to duplicate an account level item (2nd tier) and all of its 
related detail line items.  For example, if an account is set up for a crew 
member with many detail line items, the account can be duplicated for 
another crew member and then the rates modified. 

To duplicate an account level item and its related detail line items, do the 
following: 

1. Go to the Account Level Screen and select the  next to the appropriate 
account. 

2. Give the new account a name and a unique account number. 

3. Click OK. 

10.3-6 Add Detail 
To add a detail line item to an account, do the following: 

1. Click the  next to the appropriate account. 

2. The Detail Line Item Screen will appear.  
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3. Click . 

4. If Smart Entry is on, select New Detail Line Item and click OK. 

5. Choose a detail name from the pop-down list or by entering a custom 
value. 

 

 Important Note: To customize the values in the Detail Pop-Down Menu, 
from the detail screen click  to open the Value List Screen. 

6. Enter a number in the Rate field. 

7. Enter an Amount (AMT) and Quantity (QTY). 

10.3-7 Smart Entry 
Smart entry allows Gorilla to automatically enter a list of line items that are 
gathered from other parts of the program, such as a list of actors, crew, props, 
or locations. 
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Turning Smart Entry On/Off 

To turn Smart Entry on or off, click the button on the upper-right 
hand side of the detail screen. 

When Smart Entry is on, creating a new detail line item will prompt the 
following dialogue box: 

 

Each of the options is discussed below. 

New Detail Line Item 

Choose New Detail Line Item to bypass Smart Entry. 

Cast 

Choose Cast to select a character from the Story Module to insert into the line 
item.  There is also the option of importing their daily or weekly rate. 

Only characters that have a type (lead, featured, supporting) will be available. 

Crew 

Choose Crew to select a crew member from the Contacts Module to insert into 
the line item.  There is also the option of importing their daily or weekly rate. 

Only crew members that are attached to a department will be available. 

Element 

Choose Element to select an element from the Scheduling Module to insert 
into the line item.   

Only elements that are attached to a category will be available. 
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Vendors 

Choose Vendors to select a vendor from the Contacts Module to insert into the 
line item.   

Only vendors that are attached to a vendor category will be available. 

Locations 

Choose Locations to select a location from the Locations Module to insert 
into the line item. 

All Elements (Select Group) 

Choose All Elements to insert all of the elements of a group into successive 
line items.  This is a quick way to import a list of props for example. 

All Crew (Select Dept) 

Choose All Crew to insert all of the crew of a department into successive line 
items.  There is also the option of importing their daily or weekly rate. 

Banner 

Choose Banner to create a banner that serves as a heading for a number of 
line items. 

10.3-8 Sorting Detail Line Items 
Detail line items can be sorted manually.  This is especially useful when trying 
to place a banner on the correct row. 

To re-sort a line item, click the name of the line item 
and change the number.  Click Resort to rearrange the 
line items in the new order. 

 

10.3-9 Adding Notes to Detail Line Items 
To enter notes about a detail line item, select Notes. 

Notes will appear on the Detail Line Item Report.  

In-Kind Donations 

Notes will also reveal a place to indicate a line item as an in-kind donation. 

If this box is selected, the sub-total will indicate zero, but all in-kind donations 
will be sub-totaled separately in the Detail Line Item Report. 
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In the example below, 50% is selected.  This means half of the rate is donated, 
and the budget will be sub-totaled accordingly. 

 

10.3-10 Subgroups 
Individual detail line items can be attached to a subgroup.  This subgroup can 
then be included or excluded from the final budget. 

Creating a Subgroup 

To create a subgroup, do the following: 

1. Click Setup on the Command Bar and select Subgroups. 

2. Click  and name the subgroup. 

 

3. Click Done. 

Attach a Detail Line Item to a Subgroup 

To attach a detail line item to a subgroup, do the following: 

1. Click the Group Column. 

2. Select a Subgroup by clicking the desired row. 
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To attach all the detail line items in the current account to a subgroup, select 
the checkbox at the top of the dialogue box. 

Include and Exclude 

By default all subgroups are included in the budget.  Subgroups can be 
individually excluded by selecting exclude on the subgroups screen on the 
desired row. 

10.3-11 Table View 
An advanced feature in the Budget Module is the ability to see all detail line 
items for any project in one view, the Table View.  

 

On this screen it is easy to see all detail line items and to what category they 
are attached.  Line items can be deleted in this view. This is useful for 
identifying empty or unused line items in the budget that are otherwise 
difficult to find.  To exit this screen, click Return. 

10.3-12 CUME Display 
On all the budget screens, the grand total budget is 
visible from the CUME display.   

To assure that the total displayed is current, click CUME to update it. 

On slower computers or if the budget is very complex, the CUME display may 
make Gorilla sluggish.  The CUME display can be turned off in Budget 
Preferences (see Section 16.1-3 Budget Preferences). 

10.4 Ratebook 
The Gorilla Ratebook is a quick and easy way to enter industry labor rates from 
unions SAG, DGA and AFTRA directly into detail line items. 

The Gorilla Rate Book is only available in the Pro edition.   

To select a rate, do the following: 

1. Click the  on the desired line item. 

2. Select a Local # from the first pop-down menu, and then select a 
position.  If available, select a schedule. 
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3. A list of rates will appear in the rate fields (Hourly, Daily, Weekly, Flat).  
Select a rate. 

 

4. Click Attach.  

To see more clearly which rate was selected, select 
Ratebook from the View Menu on the upper right hand 
side of the Detail Screen.  

Adding/Modifying Rates 

To add or modify rates, do the following: 

1. Select Ratebook from the View menu on the Command Bar. 

2. Use the rolodex scroll bar on the left hand side of the screen to 
navigate. 

3. To add a rate, click New.  The following fields are required:  Local, 
Position, and at least one of Hourly, Weekly, Rate, or Flat. 

10.5 Globals 
Globals are numerical values that are given a name called a description. That 
description can be used on a detail line item.  If the value of the global 
changes, the value changes everywhere in the budget where that description is 
used. 
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For example, if a global with 
the description Shoot Days is 
given a value of 25, and then 
used on many detail line items, 
at any time the number of 
shoot days can be redefined to 
another amount. This is useful 
when contemplating different 
shooting scenarios. 

To access the Globals Screen, 
click Globals.  

 

 

There are two types of Globals: amounts and rates. 

A global that is defined as an amount effects the Amt column on a detail line 
item, as shown below with our example of shoot days: 

In the above example, a global given the description 
Shoot DYS was given a value of 25.  By selecting Shoot 
DYS from the Global Amt Description Column, 25 will 
appear in the Amt column. 

 

To override the global value, enter a number manually in the AMT column.  A 
blue dashed line will appear. 

A global that is defined as a rate affects the Rate column on a detail line item, 
as shown below: 

 

In the example above, a global with the description CREW 1 was given a value 
of $90. When CREW 1 is selected from the pop-down menu in the Global Rate 
Description Column, the value $90 appears in the Rate column. 

To override the global value, enter a number manually in the RATE column.  A 
green dashed line will appear. 

The Shoot Days Global 

The Shoot Days Global is special because it actually reflects the number of days 
in the active schedule.  To break this link, do the following: 
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1. Click Admin on the Main Menu and select Preferences. 

2. Click the Budget tab. 

3. De-select Auto Update Shoot Days.  

10.5-1 Showing/Hiding Globals 
A newly created global is automatically attached 
to the current budget.  To hide the global, click 
Do Not Show. 

In the example, the second global will not appear 
in the pop-down list when the Global Description 
column is selected. 

 

10.5-2 Importing Globals 
To import globals from an external source, click 
Import. 

Import 
 

To import from an Excel document, prepare the values in the order shown on 
the Import/Export Screen.  The example below shows how data in an Excel 
spreadsheet should be formatted for import. 

 

Column A: Global Name 
Column B: Description 
Column C: Value 
Column D: Category 

10.6 Fringes 
Fringes are percentages that are added to values in a budget.  Multiple fringes 
are grouped into fringe categories.  A fringe category is then attached to a 
detail line item. 
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Fringe Categories 

To create fringe categories, do 
the following: 

4. Click Setup on the 
Command Bar and choose 
Fringes. 

5. Click OK, and the 
following screen will 
appear: 

 

 

6. Click the  positioned over the Fringe Categories Window (on the left) 
to create a new fringe category. 

7. Enter a name for the category. 

8. Click  to make the fringe category active. The name of the fringe 
category will turn blue, as shown below. 
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9. Click the  positioned over the Fringe Line Items for Category Window 
(on the right).  The following screen will appear.  Specify a fringe name, 
description, percentage and cutoff amount. 

 

10. When finished, click Done. 

11. Add as many fringe line items to the category as necessary. 

 

Attaching Fringe Categories to a Detail Line Item 

After creating a fringe category, attach the fringe category to a detail line 
item. 

1. Click the 
empty fringe 
field next to 
the detail 
line item. 

2. Select a 
fringe category by clicking the  next to the desired category. The 
fringe category name will be highlighted in blue and underlined. 

3. Click . 

Modifying a Fringe Category 

A fringe category can be customized for a single line item, or changed globally 
for all line items. 

To modify fringes for a specific detail line item, do the following: 
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1. Click the total fringe amount for the appropriate detail line item. 

2. A list of fringes currently attached to that detail line item will appear. 

 

3. To add a fringe to this detail line item, click  and enter the fringe. 

4. To remove a fringe category for this detail line item, click .  

5. To return to the Budget Screen, click Close. 

To change a fringe category and update all existing fringe categories to reflect 
the update, click Update Fringe Category Globally on the Fringes 
Screen. 

 

Removing a Fringe Category from a Detail Line Item 

To remove a fringe category from a detail line item, do the following: 

1. Click the total fringe amount for the appropriate detail line item. 

A list of the fringes currently attached to that detail line item will appear. 

2. Click Remove Fringes From This Line Item. 
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Duplicating a Fringe Category 

To duplicate a fringe category to another, do the following: 

3. Click Setup on the Command Bar and choose Fringes. 

4. Click .  The following Duplicate/Reassign Fringe Categories 
Screen will appear.   

 

5. Click Dupe on the row of the desired fringe category.  The following 
screen will appear. 

 

6. Choose a project and budget to which the fringe category will be copied 
by clicking . 

Reassigning a Fringe Category 

A fringe category can be reassigned to the current budget without being 
duplicated.   

To reassign a fringe category, do the following: 

1.   Click Setup on the Command Bar and choose Fringes. 
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2. Click .  The following Duplicate/Reassign Fringe Categories 
Screen will appear.   

 

3. Select the field in the Budget Attached Column in the row of the 
appropriate fringe. 

 

4. Click OK to confirm. 

 

10.7 Saving/Loading Budgets 

10.7-1 Saving Budgets 
To save a budget, so the following: 

1. Click Budgeting on the Main Menu and select View/Create Budget. 

2. Click next to the desired budget. 

3. Choose a location to save the file. 

Saved Gorilla Budget Files will have the extension .grb. 

10.7-2 Loading Budgets 
To load a budget, do the following: 

1. Click Budgeting on the Main Menu and select View/Create Budget. 

2. Click Load. 



Budget 

-110- 

3. Find the budget and either choose load the budget into the active 
project, or to create a new project for the budget. 

10.7-3 Duplicating a Budget 
Gorilla can store multiple budgets for the same project. This is useful when 
working out different scenarios (i.e. less shoot days, lower rates, or a different 
location.) 

The easiest way to create a second budget for a project is to duplicate the 
original budget and then modify it. 

To duplicate an existing budget, do the following: 

1. Click  on the budgeting toolbar, or click Budget on the Main 
Menu and select View/Create Budget. 

 

2. Click the  located in the Dupe Column in the row of the desired 
budget. 

3. Choose Existing project.   

10.7-4 Duplicating a Budget from One Project to Another 
To duplicate a budget from one project to another, do the following: 

1. Click  on the budgeting toolbar, or click Budget on the Main 
Menu and select View/Create Budget. 

 

2. Click the  located in the Dupe Column in the row of the desired 
budget. 

3. Choose New project.   

10.7-5 Switching Between Budgets 
To switch between budgets, do the following: 

1. Click  on the budgeting toolbar, or click Budget on the Main 
Menu and select View/Create Budget. 

2. Click the  next to the desired budget. 
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10.7-6 Deleting a Budget 

1. Click  on the budgeting toolbar, or click Budget on the Main 
Menu and select View/Create Budget. 

2. Click the  next to the desired budget. 

10.7-7 Comparing Budgets 
Gorilla can compare two budgets from the same project.  

 Important Note: The compare budget feature works best when the 
categories and accounts are the same for each budget. This is why duplicating 
a budget and then modifying the rates, units, and quantities (in the detail 
level) is the best way to prepare this report. 

To compare two budgets, do the following: 

1. Click  on the budget toolbar or click Admin on the Main Menu and 
select Reports. 

2. Click select Comparison Report. 

 

3. Choose a primary and a secondary budget. 

4. Click Compare. 
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5. Click either Print or View.   If you select view, to exit comparison 

mode, click . 

10.8 Percentages 
Gorilla can add percentages to a budget. There 
are 4 types of percentages:  Contingency, 
Overhead, Insurance, and Completion Bond. 

 

Either enter a dollar amount or a percentage in the form of a decimal.  A 
percentage will be multiplied by the budget sub-total.  A dollar amount will be 
added to the budget sub-total. 

The grand total of the budget will include all the parts (Above-The-Line, 
Production, Post Production, Other) and the percentages. 

10.9 Budget Templates 
Gorilla comes with several budget templates.  They can be found in the Saved 
Budget Files folder located in the Gorilla 3.0 Folder. 

10.9-1 Importing a Movie Magic Budget as a Template 
Gorilla can import an exported text file from Movie Magic Budgeting as a 
template.  Only category and account level items will import, not the detail, 
globals, or fringes.  This procedure is for advanced users only. 

To import a text file, do the following: 

1. Use the export feature in Movie Magic Budgeting to export the budget as 
text. 

2. In Gorilla, click Budgeting on the Main Menu and select View/Create 
Budget. 

3. Select Import Other Budget Form from the File menu. 

4. Click Continue. 

5. Select Import Map On.  Click OK. 

6. An import Map will appear.  Click Continue, and then click OK. 

7. Match the fields on the left column to the fields on the right column. 

8. Click Import. 
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9. Click OK. 

10. Name the new budget Template and click OK. 

11. The template will be saved with the .grb extension. 
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Gorilla’s Distribution of Profits Module tracks profits and how to distribute 
them.  Gorilla can set up limited partnership scenarios, allocate points to cast 
and crew, and change these scenarios on the fly to see how much money there 
is to distribute and when. 

To enter the Distribution of Profits Module, click 
Budget on the Main Menu and click 
Distribution of Profits. 

The following screen will appear: 
 

 

11.1 Setup 
To set up a scenario, enter the projected budget and the projected sale.  If the 
scenario does not use points, click Limited and view a simple LP/GP (Limited 
Partnership/General Partnership) scenario. 

For example, if the budget is $1M and the projected sale is $5M, the LP/GP 
scenario would be as follows: 



Distribution of Profits 

-115- 

 

In this example, the limited partner (LP or the investors) would receive their 
$1M first, before any monies are distributed to the general partners (GP or the 
filmmakers).  After this distribution, monies are divided 50/50 between the LP 
and the GP minus any interest or other payments on the investment/loan. 

11.2 Points 
The following three types of people can invest in the film/project. They are: 

1. The Investors (LP) 

2. The Filmmakers (GP) 

3. Contact, Vendor, Cast, and/or Crew (Points) 

Points can be distributed to cast, crew, contacts, and vendors. It is therefore 
possible to assign a GP points. If this is the case, they will be taking monies 
from both scenarios. 

The options for setting up points are outlined below: 
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Options When Distributing Points 

Abbreviation Term Explanation 

LP ROI: Limited Partner 
Return on 
Investment 

How many times over the initial 
investment will the limited partner need 
to recoup before other parties (the 
general partner and profit sharing 
participants) receive profits. 

PSP ROI: Profit Sharing 
Participant Return 

on Investment 

How many times over the initial budget 
of the film must be received before the 
profit sharing participant receives points. 

Total Pts for 
Distribution 

Total Points for 
Distribution 

How many points to base the profit 
sharing participant positions. 

 

In order to distribute points to a cast or crew member, or other contact, 
Gorilla must allow profit sharing for the person. For actors, this is specified on 
the Actors Screen whereas for crew this is specified on the Crew Screen, and so 
on. 

To assign cast or crew member points, do the following: 

1. Click the Positions on tab. 

 

2. Click  and select a person/company from the list. 

 Important Note: Only names of people that have been allowed profit 
sharing will appear on this list. To assign profit sharing privileges on a project 
by project basis to an actor, crew member, vendor, or contact, go to their 
respective screens and select PSP. 

3. Enter the points to be assigned to this person.  A Profit Cap can also be 
entered here. All monies that go over the Profit Cap will be reassigned 
to the LP/GP. 

4. Click Points on the Gray Command Bar to view the three-way split. 
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The Locations Module stores information such as address, maps, and photos, 
about locations.  Locations can then be attached to breakdown sheets, and the 
stripboard then sorted by location. 

To access the Location Module, click Location on the Main Menu. 

12.1 Adding Locations 
Enter primary information for the locations. To add a new location entry, click 

. 

12.2 Importing Photos and Maps 

To add a photo or a map, click the Photo or Map tab and then click . 
Photos and Maps should be gifs or jpegs. The smaller the size of the image, the 
faster it will be to navigate through the records. 

12.3 Attaching Locations to Breakdown Sheets 
To attach a location to a breakdown sheet, do the following: 

1. Go to the Breakdown Screen. 

2. Under location, choose the desired 
location.  Only locations that are 
attached to the current project will be 
visible. 

 

3. The scene attached to that location will appear on the Locations Screen 
in the window below the location information. 

 

Click  to visit the breakdown sheet or click  to add this location to another 
breakdown sheet. 

12.4 Copying a Location to Another Project 

To reuse the same location for another project, click . Select the desired 
project. 
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The Accounting Module tracks expenses.  Use it much like a check register, 
entering all payments to cast, crew, and vendors, and entering deposits such as 
investor money, other cash, and credit card accounts. 

Gorilla can then compare expenses to the budget to see if the budget is on 
track. 

13.1 Creating an account 
To create an account, do the following: 

1. Click Accounting on the Main Menu and then click Accounts. 

2. When prompted to create an account, enter primary information for that 
account. 

 

Choose an account type so that Gorilla knows if the account is Credit or Debit. 

Click 
Link to
Budget  to choose the desired budget. 

This is a powerful means of comparing  budget vs. expenses. 

13.2 Entering Transactions 
To enter the first transaction, do the following:  

1. Click the Register tab. 

2. Click . 

 

If this is a deposit, select plus in the +/- field. Enter the amount. When 
finished, click Done.  
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13.2-1 Tracking an Expense to a Budget 
To attach an expense to a specific budget line item, do the following: 

1. In the Pay To/Deposit field, enter the appropriate cast, crew, or vendor. 
The entries in these fields are taken directly from the Cast, Crew, and 
Vendor Screens. 

2. Under Budget Accounting, enter the appropriate Category and Account. 

3. Print a Budget Balance Report to see the difference between what you 
budgeted and what you actually spent.

 



Editing

14. Editing 

 

-120- 

Gorilla’s Editing Module can track scene information during the editing process. 
Make notes on which takes to use, where your media is stored, if audio takes 
can be heard, etc. 

Gorilla can import all this information from Final Cut Pro, or from the disks 
supplied by the film transfer lab. 

To include a Quicktime movie of a scene, click Import Scene. 

 

To play the movie, do the following: 

1. Click the clip. 

2. The control buttons will appear.  Click Play. 
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Gorilla comes preset with over 120 film festivals, but can store many more. 
This module is used to track a project’s film festival entries. 

 

To view the detail information for the current film festival, click . 

There are tabs: General, Entry, Response, and Notes. 

General:  General information about the film festival, including 
address, phone, web info, deadlines, and theme. 

Entry: Projects that are entered into the festival, fees, and entry 
notes. 

Response: The film festival’s response. 

Notes: Miscellaneous notes for each festival and the project 
entered into the festival. 

To track a film festival, do the following: 

1. Click the Entry tab. 

2. Click . 

3. Select the desired project. 

4. To track the response(s) for this and other projects, click the Response 
tab and enter status of response information
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16.1 Preferences 
Preferences are customizable choices that 
affect the display, printing, sorting, format, 
reporting, and other functions. 

To set preferences, click Admin on the Main 
Menu and then click Preferences. 

 

16.1-1 Login Preferences 
Login Name: Current user logged in. 

Access Level: Access level of current 
user. 

Access Rank: Rank of current user. 

Project for this session: The active 
project. 

Production Company Info: Production 
company, address, and phone numbers 
for currently selected production 
company. 

 

Clicking Update Production Info will populate the production company 
information for this project. After changing the production company 
information in the Projects Module, clicking this button will update this 
information throughout the program. 

Production Company information is printed on most of the reports. The address 
and phone info can be suppressed using a preference in the General 
preference tab (See Section 16.1-8 General). 
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16.1-2 Budget Preferences 
1) When viewing a budget, the top 
sheet opens first if checked.  
Otherwise, the first section will open, 
such as Above the Line. 

2) If this box is checked, the Top 
Sheet Screen will be inaccessible. 
Older computers may take some time 
to redraw the top sheet, so checking 
this box will speed things up. 

3) If this box is checked, top sheet 
subtotals will be automatically 
calculated.  If not, update the 
subtotals by clicking Update 
Subtotals on the Top Sheet Screen. 

4) The Shoots Days Global in the 
budget is linked to the shoot days in 
the schedule if checked. 

5) Turns Smart Entry on.  For more 
about Smart Entry, see Section 10.3-7 
Smart Entry. 

6) Attaches category name to 
element when importing elements 
during smart entry. 

7) Checking this box will disable the 
CUME display, speeding up the 
performance of the budget. 

 

8) Opens a dialogue box that assists the user in importing a Movie Magic Export 
Budget File (text). 

9) Displays the names of subgroups attached to the active budget. 

10) If this box is checked, the line items in the Budgeting Module will be 
displayed in a smaller font so that more information in viewable on the screen. 
Also, the toolbar on the top of the screen will be hidden. 

11)  When checked, Gorilla suppresses empty or zero line amounts so that only 
those line items which have values are printed. 
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12) When checked, the Detail Level Report prints without fringes. 

13) When printing the Detail Level Report, check this option to print the report 
without fringes, amounts, quantity, rates, and subtotals.  This will make the 
report simpler to read for high-level investors. 

14) If checked, notes will print in the Print Small layout.   

16.1-3 Strips Preferences 
1) The default stripboard view is either 1-
Column, 2-Column, or 9-Column. 

2) When displaying the stripboard, 
smaller strips will appear. 

3) When printing the stripboard, show 
sheet numbers on strips.  

4) When printing stripboards, banners will 
print. 

5) Allow more room for scene #’s and 
character ID’s on printed stripboard. 

6) Show page count on daybreaks in the 
stripboard display.  This slows down the 
display of strips on slower computers.  
The page count will always print, 
however. 

7) Gorilla will automatically renumber 
strips when exiting reorder mode.  This 
only applies to renumbering strips the old 
Gorilla 2.x way. 

8)  The default number of pages when 
using auto day breaks.  When strips reach 
the max, the day break is placed after the 
last strip if this is selected.  

9) If all day breaks are added together, this will place them all at the head of 
the stripboard as opposed to then.   

10) Show More Strip Preferences (see below). 



Admin 

-125- 

16.1-4 More Strips Preferences 
1) Gorilla updates the stripboard 
before running scheduling reports.  
Reports will take longer to print if this 
is selected. 

2) Gorilla prompts user to update the 
stripboard each time a scheduling 
report is printed. 

3) Gorilla will update the stripboard 
each time a daybreak is moved. 
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16.1-5 Breakdown Preferences 
1) Automatically number scenes 
based on previous scene entry, or 
specify what number at which to start 
the next scene. 

2) Automatically number sheets based 
on previous sheet entry, or specify 
what number at which to start the 
next sheet. 

3) When viewing breakdown sheets, 
specify the sort. 

4) Mini-strips are a smaller version of 
the stripboard displayed alongside the 
Breakdown Sheet Screen. Mini-strips 
can be turned on or off. Scene 
numbers can be displayed within the 
mini-strips. 

5) When printing breakdown sheets, 
print 1-, 2- or 3-page sheets. 1- page 
sheets print up to 18 categories, 
whereas 2- and 3- page sheets print all 
21 categories. 
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16.1-6 Reports Preferences 
1) When printing a Shooting Schedule 
Report specified for days, this report 
will page break between days if 
selected. 

2) When printing a Shooting Schedule 
Report specified for scenes, this will 
page break between scenes if 
selected. 

3) When printing a Shooting Schedule 
Report specified for scenes, this will 
page break between days if selected. 

4) When printing a Shooting Schedule 
Report, no page breaks are added. 

5) Sort the above reports by Element 
ID or by Element Name. 

6) When printing Crew and Scene Call 
Sheets, prompt before each page. 

7) When checked, the Element ID is 
included on breakdown sheets. 

8) Element ID’s can be displayed two 
ways. 

 

16.1-7 Users 
Displays all users and their access levels. 
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16.1-8 General 
1) If this box is checked, the default 
Print Setup Dialog Box will appear 
every time a report is printed. 

2) If checked, a preview of the report 
will appear before it prints. 

3) If this box is checked, when 
importing data from another source, 
the path to the field import map will 
appear. 

4) To hide start-up tips, click here. 

5) When checked, address and phone 
info will be printed on reports. 

6) For best screen resolution, the 
monitor should be set to either 768 x 
1024 or 870 x 1152 (an exception to 
this is the Apple Cinema Display). When 
this option is selected, Gorilla will 
display a warning is the monitor is set 
to the wrong resolution. 

7) Set how many days cast members 
are held before dropped, and display 
Day out of Days on one large 
spreadsheet as opposed to multiple 
screens. 

8) To help limit pages to shoot per 
day, Gorilla will issue a warning before 
printing the stripboard if a shoot day is 
over that limit. 

 

9) Set the Main Menu position and placement (vertical or horizontal). 

10) If checked, Gorilla will close windows not being used. 

11) If checked, automatically moves the Main Menu to accommodate larger 
windows. 

12) Resets all windows to default position. 

13) Hides all windows. 
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16.1-9 Currency 
1) Format the number of decimal 
places. 

2) Specify decimal separator. 

3) Specify thousands separator. 

4) Specify a leading string here. 

5) Specify a trailing string here. 

6) To modify or add more currency 
values, click here. 

7) Specify default leading strings. 

8) Specify default trailing strings. 

9) This option converts all of the 
monetary amounts in the program to 
another currency.  For example, to 
see what the budget will look like in 
EUROS, enter a conversion multiplier 
here and make sure the formatting for 
currency is set to Euros. By default, 
this should be set to 1. 

10) Changing these settings affect the 
way dates appear on reports. By 
default, the date will appear as 
month/day/year. 
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16.1-10 Crew 
1) When printing a Crew Call 
Summary Report, sort by department. 

2) When printing a Crew Call 
Summary Report, page break between 
shoot days. 

3) When printing Crew and Scene Call 
Sheets, prompt before each page. 

4) Sort Crew Reports by department 
ID or by department name. 

5) Sort Crew Reports by last name, 
title, or by a custom sort order. 
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16.1-11 Shots 
1) A thumbnail-size image of 
the shot appears next to the 
description. 

2) The details will print in the 
Shot List Report. 

3) Displays Bird’s-Eye View on 
Detail Shot Screen.  If 
unchecked, Scene Info will 
display instead. 

4) Sorts shot list by script 
order. 

5) Sorts shot list by setup 
order. 
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16.1-12 Misc 
6) When entering the Cast Call Times 
Screen, changes from the stripboard 
are automatically recalculated. 

7) When assigning an off day or a 
holiday, the Shoot Days Screen is 
updated automatically.  If this option 
is turned off, shoot days must be 
manually updated.  (To manually 
update shoot days, click Shoot Days 
on the Shoot Days Screen.) 

8) Upon entering the Day Strips 
Screen, reset the displayed shoot days 
from the beginning of the production. 

9) Gorilla will prompt the user to 
import a screenplay if there are no 
characters in the active project. 

 

16.2 Value Lists 
Many of the screens have value lists in the 
form of pop-down menus. Most of the time, 
the values can be modified. There are two 
ways to access the Value List Screen. 

1) Click Admin on the Main Menu, and then 
click Value Lists. 

or  

2) Click the  next to the pop-down list you want to modify. 
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To add a value to the group, click .  To remove a value from the group, click 
. 

The following is a list of all the value groups that have modifiable values: 

Modifiable Value Groups  

Group Screen 

Age/Range Character 
Agents/Managers Actor 

Angle of View Scheduling 
Budget Section Budgeting 
Camera Height Scheduling 

Casting Directors Actor 
Character Type Character 

Company Contacts 
Crew Parking Locations 

Crew Title Crew 
Currency General 

Department Crew 
Detail Budget 

Equipment Scheduling 
Event Type Calendar/Datebook 
Eye Color Actor 

Focal Length Scheduling 
Fringes Budget 
Genre Projects 

Group Name Scheduling 
Hair Color Actor 
Hospitals Scheduling 
How Paid Accounting 
Lighting Scheduling 

Other Title Contacts 
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Modifiable Value Groups  

Group Screen 

Phase Scheduling 
Rating Film Festival 

Shot List Scheduling 
Stripboard Scheduling 

Type of Account Accounting 
Union Actor/Crew 
Units Budget 

Vehicles Scheduling 
Vendor Category Vendor 

Weather Scheduling 
Writers Projects 

Certain values cannot be deleted. These values are indicated by a . 

16.3 Upgrade/Versions 

16.3-1 Difference Between the Student, Standard and Pro 
Editions 

The following table explains the difference between the different editions of 
Gorilla. 

Gorilla’s Three Editions 

Edition Shoot Day Limit Budget Limit 

Student 14 Shoot Days* $50,000 per 
budget 

Standard 48 Shoot Days* $625,000 per 
project 

Pro Unlimited Unlimited 

* Shoot Day Limit: This is across multiple production phases. For example, if 
Phase 1 = 3 days, Phase 2 = 4 days, and Phase 3 = 7 days, the Student 
Edition can be used. 

16.3-2 Upgrading to Standard or Pro 
The Student Edition can be upgraded to Standard or Pro, and the Standard 
Edition can be upgraded to Pro at any time. In order to do this, do the 
following: 

1. Contact Jungle Software and purchase a new serial number. 
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2. Click Admin on the Main Menu, and then click 
Upgrade/Authorize. 

3. Click Upgrade. 

4. Enter the new serial number. 
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Jungle Software is located at the following address: 

12711 Ventura Blvd., Suite 345 
Studio City, CA  91604 
(818) 508-7090 
(818) 487-7865 (fax) 

For tech support, please email us: 

support@junglesoftware.com

For marketing opportunities, or to become a reseller of Gorilla, e-mail Ethan 
Markowitz, Director of Product Development: 

ethan@junglesoftware.com

For custom database solution, please contact Debbie Cohen-Sitt of our parent 
company, The Database Factory: 

debbie@thedatabasefactory.com

For suggestions about how to improve future versions of Gorilla, please contact 
Gorilla’s primary developer, Aaton Cohen-Sitt: 

aaton@junglesoftware.com
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Troubleshooting Guide/FAQ 

Question Answer 

My serial number doesn’t work. Your serial number is a function of 
your name and company.  It is just as 
important to type in your serial 
number correctly as your name and 
company.  They must be exactly the 
same as when you registered.  
Capitalization counts! 

I am no longer going to use an old 
computer.  How do I take Gorilla off 
the computer, and bring it to another? 

To do this, you must deauthorize your 
old computer.  To deauthorize, click 
Admin on the Main Menu and click 
Upgrade/Authorize.  Click 
Deauthorize.  Now you have a free 
install for the new computer. 
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59 
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